Thank you for purchasing TOA Digital Mixer. Please carefully follow the instructions in this manual to ensure long, trouble-free use of your equipment.
# TABLE OF CONTENTS

1. **GENERAL DESCRIPTION OF THE D-2000 SETTING SOFTWARE** ............................................................. 6

2. **SOFTWARE SETUP**
   2.1. Installing the D-2000 Setting Software ............................................................... 7
   2.2. Uninstalling the D-2000 Setting Software .......................................................... 9

3. **STARTING THE SOFTWARE** ............................................................................... 10

4. **MAIN SCREEN AND MENU ITEM DESCRIPTION**
   4.1. Main Screen ..................................................................................................... 11
   4.2. Menu Item Description
      4.2.1. File ......................................................................................................... 12
      4.2.2. Edit ......................................................................................................... 12
      4.2.3. View ....................................................................................................... 12
      4.2.4. Unit ......................................................................................................... 13
      4.2.5. Memory .................................................................................................. 13
      4.2.6. Communication ...................................................................................... 13
      4.2.7. Option .................................................................................................... 14
      4.2.8. Help ........................................................................................................ 14

5. **UNIT CONFIGURATION AND SYSTEM-RELATED SETTINGS**
   5.1. D-2008SP Configuration Settings .................................................................... 15
   5.2. D-2012C Configuration Settings ...................................................................... 24
   5.3. Unit Change or Deletion and Slot Information Confirmation
      5.3.1. Deleting the unit ..................................................................................... 25
      5.3.2. Changing the unit configurations ........................................................... 25
      5.3.3. Confirming the slot information .............................................................. 26
      5.3.4. Changing the unit names ....................................................................... 27

6. **MAIN SCREEN AFTER COMPLETION OF UNIT CONFIGURATION** ......................................................... 28
   6.1. Unit View .......................................................................................................... 29
   6.2. Connection Status View ................................................................................... 30
   6.3. Memory View ................................................................................................... 31
   6.4. Monitor View .................................................................................................... 33
   6.5. Level Monitor View
      6.5.1. When the D-2008SP is selected ............................................................ 34
      6.5.2. When the D-2012C is selected .............................................................. 36
   6.6. All Mute View ................................................................................................... 36
   6.7. Routing Monitor View ....................................................................................... 37

7. **D-2008SP FUNCTION SETTINGS**
   7.1. Flow View ......................................................................................................... 38
      7.1.1. Input flow view ....................................................................................... 39
      7.1.2. Bus flow view ......................................................................................... 40
      7.1.3. Output flow view ..................................................................................... 41
   7.2. Matrix View
      7.2.1. Input Matrix view (Bus assignment and crosspoint gain settings) .......... 42
      7.2.2. Output Matrix view (Output assignment and crosspoint gain settings) ... 45
7.3. Contents View ................................................................. 46

7.3.1. Module view
[Microphone/line Input module view (Available only when the D-921E, D-921F, or D-2000AD1 is used)] ................................................................. 47
[Digital Input module view (Available only when the D-923AE or D-937SP is used)] ............................................................................. 49
[Stereo Input module view (Available only when the D-936R is used)] ................................................................. 51

7.3.2. Trim view (Input trim settings) ................................................................. 52

7.3.3. Input filter view (High-pass filter/equalizer/low-pass filter settings) ................................................................. 53

7.3.4. Comp/leveler view (Compressor/Auto-Leveler function settings)
[Compressor function settings] ............................................................................. 56
[Auto-Leveler function settings (Available only for the input channel)] .. 59

7.3.5. Automix view (Auto-mixing Function Settings)
[Gate function settings] ............................................................................. 61
[NOM attenuation function settings] ................................................................. 64
[Ducker function settings] ............................................................................. 65

7.3.6. Fader view (Input/bus/output gain, input/bus/output VCA display, and input/bus/output group trim settings) ................................................................. 66
[Input, Bus, and Output gain settings (Fader display)] ......................... 67
[Input, Bus, and Output VCA displays] ................................................................. 68
[Input, Bus, and Output group trim settings (Group trim display)] ........ 69

7.3.7. Sub In Mix view ...................................................................................... 70

7.3.8. Delay view (Delay function settings) ................................................................. 71

7.3.9. FBS view (Feedback suppression function settings) ............................. 73
[Feedback suppression function operations] ................................................................. 75

7.3.10. Xover view (Crossover function settings)
[Crossover function settings] ............................................................................. 76
[Time correction settings between Xover boxes] ................................................................. 79

7.3.11. Output filter view (Filter function settings) ................................................................. 80

7.3.12. Mute view ............................................................................................. 83

7.4. D-981, D-983, and D-984VC Control Modules Settings

7.4.1. General description of the D-981, D-983, and D-984VC ....................... 84

7.4.2. Contact input setting screen ................................................................. 85
[Contact input function assignment: Memory] ................................................................. 86
[Contact input function assignment: Volume Up or Down] ................................................................. 86
[Contact input function assignment: Channel On/Off] ................................................................. 88
[Contact input function assignment: Line Input] ................................................................. 89
[Contact input function assignment: LED control] ................................................................. 90

7.4.3. Contact output setting screen ................................................................. 91
[Contact output function assignment: Memory] ................................................................. 92
[Contact output function assignment: Channel On/Off] ................................................................. 93
[Contact output function assignment: Line Input] ................................................................. 93
[Contact output function assignment: LED Control] ................................................................. 94
[Contact output function assignment: Through Out] ................................................................. 95
[Contact output function assignment: Console Switch] ................................................................. 96

7.4.4. VCA module setting screen (Only when the D-984VC is used) .......... 97
[VCA Channel Assignment] ............................................................................. 98

7.5. CobraNet Module Settings

7.5.1. Unicast bundle example ............................................................................. 100

7.5.2. Multicast bundle example ............................................................................. 101

7.5.3. CobraNet bundle settings ............................................................................. 101

7.5.4. CobraNet bundle matrix settings ............................................................................. 103
13.1.2. System configuration ................................................................. 152
13.1.3. Equipment layout ................................................................. 153
13.1.4. System diagram ................................................................. 153

13.2. Setting Example for Use in Multi-Purpose Halls
13.2.1. System description ................................................................. 154
13.2.2. System configuration ................................................................. 154
13.2.3. Equipment layout ................................................................. 154
13.2.4. System diagram ................................................................. 155

13.3. Setting Example for Use in Hotel's Banquet Halls
(Change Safe function is used.)
13.3.1. System description ................................................................. 156
13.3.2. System configuration ................................................................. 156
13.3.3. Equipment layout ................................................................. 156
13.3.4. System diagram ................................................................. 157
13.3.5. Description for settings ................................................................. 158

14. SPECIFICATIONS
14.1. Software Specifications ................................................................. 159
14.2. Setting Items, Setting Ranges, and Initial Value
14.2.1. Communication settings ................................................................. 159
14.2.2. Signal processing box ................................................................. 159
14.2.3. Settings when the CobraNet module is used ................................. 164
14.2.4. Settings when the external control port is used ................................. 165
14.2.5. Settings when the D-921E or D-921F is used ................................. 165
14.2.6. Settings when the D-2000AD1 is used ................................................................. 165
14.2.7. Settings when the D-937SP is used ................................................................. 165
14.2.8. Settings when the D-936R is used ................................................................. 165
14.2.9. Settings when the D-981, D-983, or D-984VC is used ................................. 165
14.2.10. Settings when the D-2012C is used ................................................................. 166
14.2.11. Security settings ................................................................. 166
14.2.12. Change Safe setting ................................................................. 166
14.2.13. Preset Memory Settings ................................................................. 167
1. GENERAL DESCRIPTION OF THE D-2000 SETTING SOFTWARE

The D-2000 system is comprised of the D-2008SP Digital Mixing Processor, the D-2012C Remote Console and the dedicated software used to perform settings for each unit. (In this manual, both the D-2008SP and D-2012C are collectively referred to as the "Unit.")

For the D-2008SP, use the dedicated setting software to set the following acoustic signal processing functions and to perform the settings for each installed module.

The largest-scale system can be configured with 4 D-2008SPs, 4 D-2012Cs, and 1 PC.

- Feedback suppressor (FBS) function
- Matrix function
- Trim gain function
- Fader function
- Filter function
- Crossover function
- Delay function
- Compressor/Leveler function
- Auto-mixing function

Equipped with 8 function keys, 12 motorized faders, and 8 rotary encoders, the D-2012C can control the D-2008SP's signal processing parameters and faders (volumes).

Settings can be performed regardless of whether the PC and the unit are in communication (online) or not (offline). Note that prior parameter settings for feedback suppression, level monitor and compressor reduction indication cannot be displayed or operated without being online. The PC communicates with the unit via a network. While they are online, the PC can remotely recall preset memories and change the settings of acoustic signal processing on the unit in real time.

Set data can be stored in the PC.

Install the supplied D-2000 Setting Software on a PC meeting the requirements below.

[Recommended PC requirements]

<table>
<thead>
<tr>
<th>Hardware Requirements</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>2 GHz, Intel Pentium 4 or higher</td>
</tr>
<tr>
<td>Memory</td>
<td>Over 1.5 GB (2 GB or more recommended)</td>
</tr>
<tr>
<td>Display</td>
<td>1024 x 768 resolution or higher</td>
</tr>
<tr>
<td>Free Hard Disk Space</td>
<td>Over 16 MB (for D-2000 Setting Software installation) or over 500 MB (when &quot;.NET Framework&quot; needs to be installed)</td>
</tr>
<tr>
<td>CD/DVD Drive</td>
<td>CD-ROM drive</td>
</tr>
<tr>
<td>LAN Card</td>
<td>Compatible to 10BASE-T or faster connection</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Software Requirements</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>OS</td>
<td>Windows XP Service Pack 2 or later, 32/64-bit Windows Vista, 32/64-bit Windows 7</td>
</tr>
<tr>
<td></td>
<td>Following are the verified operating systems:</td>
</tr>
<tr>
<td></td>
<td>Windows XP Service Pack 2 (Home Edition, Professional)</td>
</tr>
<tr>
<td></td>
<td>32-bit Windows Vista Service Pack 2 (Ultimate, Business)</td>
</tr>
<tr>
<td></td>
<td>64-bit Windows Vista Service Pack 2 (Business)</td>
</tr>
<tr>
<td></td>
<td>32-bit Windows 7 (Ultimate, Professional)</td>
</tr>
<tr>
<td></td>
<td>64-bit Windows 7 (Professional)</td>
</tr>
<tr>
<td>Required Component</td>
<td>.NET Framework 3.5 SP1 (included on the supplied CD)</td>
</tr>
</tbody>
</table>

Notes
- Pentium is a trademark of Intel Corporation.
- Windows and Windows Vista are trademarks of Microsoft Corporation.
- Regarding other company names and products, they are also trademarks of individual companies.
2. SOFTWARE SETUP

2.1. Installing the D-2000 Setting Software

Terminate all other application programs in operation before installation. Follow the procedures below to install.

**Step 1.** Insert the supplied CD into the PC's CD drive.

**Step 2.** Open the CD drive from the "Explorer" or "My Computer." The "English" folder, "Japanese" folder, and other contents are displayed.

**Step 3.** Open the "English" folder.

**Step 4.** Open the "D2000_Software" folder.

**Step 5.** Double-click the "setup.exe." The following window is displayed.

**Step 6.** Check the contents of the window, then click the "Next" button. The following window is displayed.
Step 7. If necessary, change the folder into which the software will be installed, then click the "Next" button. The following window is displayed.

Step 8. Start installation according to the instructions on the screen. 

Note
If the .NET Framework is not installed in the PC, follow the on-screen instructions to install it.

Step 9. Click the "Close" button after installation completion. The shortcut icon for the D-2000 GUI executable program is stored in the PC's start menu.
2.2. Uninstalling the D-2000 Setting Software

Step 1. Click the Start button on the PC's desktop, and select "Setting → Control Panel."

Step 2. Double-click the following icon.
   - Windows Vista and Windows 7: "Programs and Features"
   - Windows XP: "Add or Remove Programs"
   The currently installed program will then be displayed.

Step 3. Select "D-2000 GUI."

Step 4. Click the following button to uninstall the software.
   - Windows Vista and Windows 7: "Uninstall"
   - Windows XP: "Delete"
3. STARTING THE SOFTWARE

The following two different methods are available for starting the installed D-2000 Setting Software:

(1) Starting from the "Start" menu

You can start the D-2000 Setting Software from the start menu.

Click the Start button on the PC's desktop, and select "Programs → TOA Digital Audio Control → D-2000 GUI" to start.

(2) Starting from the shortcut icon

You can start the D-2000 Setting Software by double-clicking the shortcut icon created on the desktop after installation completion.
4. MAIN SCREEN AND MENU ITEM DESCRIPTION

4.1. Main Screen

Starting the D-2000 Setting Software causes the main screen to appear.

Menu (See the next page.)

Main view (See p. 38 and 106.)

Monitor view (See p. 33.)

Memory view (See p. 31.)

Unit view (See p. 29.), Connection status view (See p. 30.)
4.2. Menu Item Description

4.2.1. File

New: Creates (sets) a new data file.
Open... : Calls up the existing data file.

Note
The following logon screen may be displayed.

![Administrator Logon](image)

This screen appears when a user level is set.
(Refer to p. 124, "Logging on when the user level is enabled.")

Save: Overwrites the file being edited.
Save As... : Saves the file being edited under a different name.
Exit: Exits the D-2000 Setting Software.
Import: Imports (loads) only the information on the D-2008SP with ID1 out of the existing data files, and adds it into the file being edited.

Note
It is not possible to import the information on the D-2012C and the one on the D-2008SP other than that with ID1.

4.2.2. Edit

Copy: Copies the value set for the function box selected on the flow view (see p. 38) to the clipboard.
Paste: Pastes the data in clipboard to the function box selected on the flow view.
Initial value: Initializes the value set for the function box selected on the flow view.
Box Write Protect...
  Off: Sets no restriction on write to box.
  Low: Restricts the operator from changing the parameters set in the box.
  Mid: Restricts the operator from changing all settings in the box.
  High: Restricts the administrator from changing the parameters set in the box, and the operator from changing all settings in the box.

4.2.3. View

Contents View...
  Show/Hide: Shows or hides the contents view. (See p. 46.)
  Floating: Floats the contents view window.
  Docking: Docks the contents view window.
Level Monitor View...
  Show/Hide: Shows or hides the level monitor view. (See p. 34.)
  Floating: Floats the level monitor view window.
  Docking: Docks the level monitor view window.
  Split: Displays the different level areas in a single D-2008SP one above the other.
All Mute View...
  Show/Hide: Shows or hides the all mute view. (See p. 36.)
  All Mute: Turns on or off the all mute function.
Routing Monitor View...
  Show/Hide: Shows or hides the routing monitor view. (See p. 37.)
4.2.4. Unit

Create New Unit... : Creates a new unit. (See p. 15 and p. 24.)
Delete Unit... : Deletes the unit from the setting data. (See p. 25.)
Change Unit Configuration... : Changes the unit's input/output configuration. (See p. 25.)
Slot Information... Lists the module configuration stored in the unit and the cognitive information of the slot-mounted modules. (See p. 26.)
Names... : Changes the names of the unit and its inputs and outputs. (See p. 27.)

4.2.5. Memory

Change
Memory (1 – 32): Recalls one out of 32 preset memories. (See p. 147.)
Store
Memory (1 – 32): Writes setting contents in one of 32 memories. (See p. 147.)
Memory Setting: Performs the following settings concerning the preset memory. (See p. 148.)
  • Name setting
  • Cross fade Time
  • Fader Layer Recall

Power ON
Last Memory/Memory (1 – 32): Select the preset memory to be recalled when the unit's power is turned on from the Last Memory or 32 memories.
If you select the Last Memory, the unit starts with the last recalled preset number before turning off the power.
Note
When the Change Safe function (see p. 126) is used, "Last Memory" or any preset memory to which the Change Safe group or groups have been assigned cannot be set for the Power On Memory function.

4.2.6. Communication

Connect... : Connects the unit to a PC for online processing. (See p. 139.)
Disconnect... : Disconnects the unit from a PC for offline processing. (See p. 146.)
Note
The unit's setting does not change while in the offline state even if it is changed with a PC.
Bulk Transmission... : Transmits data of the currently opened file to the unit. (See p. 139.)
Bulk Receiving... : Receives the unit's data. (See p. 139.)
Auto Connection: Makes an automatic connection when the file is opened next time.
Firmware: Displays the unit's firmware version number. (Only valid when connected online)
Comm Setting... : Allows you to perform network settings and to designate the unit's IP address to which this software can access. (See p. 131.)
4.2.7. Option

- **Security Settings**: Set the user level and the restriction of operations. (See p. 123.)
- **Change Safe Setting**: Performs the Change Safe function while offline. (See p. 126.)
- **Console SEL/MONI Link Setting**: Performs the console SEL/MONI interlock setting. (See p. 129.)
- **Contact Input Setting...**: Sets the contact inputs of the D-981 or D-983 Remote Control Module, or the D-984VC VCA Control Module. (See p. 85.)
- **Contact Output Setting...**: Sets the contact outputs of the D-981, D-983, or the D-984VC. (See p. 91.)
- **VCA Module Setting...**: Sets fader assignments for the D-984VC VCA Control Module. (See p. 97.)
- **CobraNet Module Setting**
  - **CobraNet Bundle Setting**: Sets the CobraNet bundle number for the selected unit. (See p. 101.)
  - **CobraNet Bundle Matrix Setting**: Sets the CobraNet bundle number in matrix format when 2 or more D-2008SPs (max. 4 units) are CobraNet-connected to each other. (See p. 103.)
- **Wordclock Setting...**: Selects the synchronization for the word clock. (See p. 104.)
- **External Control Port Setting...**: Sets interface communication speed with such external control equipment as the AMX. (See p. 105.)
- **Fader Layer Change Layer (1 – 4)**: Recalls the D-2012C's fader layer. Layers not assigned to D-2012C's function keys cannot be recalled. (See p. 122.)
- **Power On Fader Layer Last Layer/Layer (1 – 4)**: Selects the fader layer to be recalled when the D-2012C's power is switched on. Selection is made from either the Last Layer or Layers 1 – 4. Layers that have not been assigned to the D-2012C's function keys cannot be selected. Selecting Last Layer causes the D-2012C to start with the layer number recalled just before the power was switched off. (See p. 122.)
  
  **Note**
  This setting is valid only when the Fader Layer Recall function is set to "None." (See p. 122.)

- **Console Setting**: Performs the channel setting of the D-2012C Remote Console Unit. (See p. 119.)

4.2.8. Help

- **About...**: Displays the D-2000 Setting Software version number.
5. UNIT CONFIGURATION AND SYSTEM-RELATED SETTINGS

5.1. D-2008SP Configuration Settings

**Step 1.** Select "Unit → Create New Unit..." from the menu.
   The Unit Configuration setting screen is displayed.

![Unit Configuration Screen]

**Step 2.** Enter a unit name.
   Up to 20 alphanumeric characters can be used.

**Step 3.** Set Unit Type.
   Select the D-2008SP as the Unit type to be created.

**Step 4.** Set the Processor ID number by selecting it from the Combo box. (Setting range: ID1 – ID4)
Step 5. Click the "Next" button.
The I/O Setting screen is displayed.


Notes
- CobraNet is a trademark of Cirrus Logic, Inc.
- The unit having only inputs or outputs cannot be created.

6-1. Module Setting
Select the type of module (input, output, and control) by clicking the appropriate checkbox for each slot and select the modules to be used from the Combo box.
- For Slots 1 – 6, input modules and output modules can be selected.
- For Slots 7 and 8, input modules, output modules, and control modules can be selected.

The Combo box's content changes depending on the content selected in the checkbox.

Note
Signals of the input and output modules are separately processed by 2 DSP devices, each of which handles the modules in determined slot numbers as follows.
- DSP #1: Modules in Slot 1 – Slot 4
- DSP #2: Modules in Slot 5 – Slot 8
As the available filter number for input and output channels is limited by the DSP in charge, design in which slots modules are installed making the filter number as equal as possible for 2 above-mentioned slot groups. (See p. 21, Filter Point Number Setting Screen.)

6-2. Bus Setting
Select the number of buses to be used from the Combo box. (Default setting: "8")

6-3. CobraNet Setting
Click the input or output checkbox for A or B channel.

Note
Do not tick the CobraNet Setting item when the CobraNet interface module is not installed.
If it is ticked in this case, audio signals from other modules may not be output.

6-4. Console Setting
Click the checkbox when using the D-2012C's line input terminal. The D-2008SP's monitor bus terminal must be connected to the D-2012C's monitor bus terminal. (For details, please read the separate installation manual.)
Step 7. Click the "Next" button.
The Channel Use screen is displayed.

Step 8. Set Channel Usage.

8-1. Input Channel Use Settings
Select the use to be assigned to each module slot in 2-channel units from "Audio," "Ext.In," or "Monitor."

* "Ext. In" is the external input used for direct input to the output matrix. Refer to the block diagrams included in the separate installation manual.

Notes
- Slot 1 – Slot 4 cannot be used for "Monitor."
- The input modules used for "Monitor" are subject to the restrictions listed below.

<table>
<thead>
<tr>
<th>Input module</th>
<th>Availability</th>
<th>Restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-2000AD1, D-921F, D-921E</td>
<td>Usable</td>
<td>&quot;Phantom power&quot; is fixed to &quot;OFF,&quot; and &quot;Input sensitivity&quot; to &quot;+4 dB.&quot;</td>
</tr>
<tr>
<td>D-923F, D-922E</td>
<td>Usable</td>
<td>Set &quot;Phantom power&quot; to &quot;OFF,&quot; and &quot;Input sensitivity&quot; to &quot;+4 dB&quot; using the DIP switch.</td>
</tr>
<tr>
<td>D-923AE</td>
<td>Usable</td>
<td>The setting status cannot be displayed on the D-2000 Setting Software.</td>
</tr>
<tr>
<td>D-936R, D-937SP</td>
<td>Not usable</td>
<td>Not usable</td>
</tr>
</tbody>
</table>

8-2. Output Channel Use Settings
Select the use to be assigned to each module slot in 2-channel units.
It can be selected in "Audio."
"Monitor" can be set to each D-2008SP's ID number from 4 monitor channels. (See p. 19.)
When the channel to be monitored is selected on the D-2000 Setting Software or D-2012C, audio on the corresponding channel of this unit is output.
Step 9. Click the "Next" button.
• Checking the input checkbox in "CobraNet Setting" on the I/O Setting screen causes the CobraNet Channel Use screen to be displayed. (Advance to Step 10.)

<table>
<thead>
<tr>
<th>CobraNet Channel Use</th>
<th>CobraNet In</th>
<th>CobraNet Sub In</th>
<th>CobraNet Bus</th>
</tr>
</thead>
<tbody>
<tr>
<td>CobraNet A1-2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CobraNet A3-4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CobraNet A5-6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CobraNet A7-8</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

• If the input checkbox remains unchecked in "CobraNet Setting" on the I/O Setting screen, the channel setting screen (same screen as in Step 11) is displayed. (Advance to Step 12 on the next page.)

Step 10. Set the CobraNet Channel Use Settings.
Select the use for each CobraNet channel in 2-channel units.
Select from "CobraNet In," "CobraNet Sub In," or "CobraNet Bus."

Step 11. Click the "Next" button.
The Channel Setting screen is displayed.
Step 12. Perform Input and Output Channel Selection.

12-1. Input Channel Selection
• Select the modular slot channels to be assigned to each input channel in 2-channel units.
• Select the CobraNet channels to be assigned to each input channel in 2-channel units.

12-2. Output Channel Selection
• Select the modular slot channels to be assigned to each output channel in 2-channel units.
• Select the CobraNet channels to be assigned to each output channel in 2-channel units.

Step 13. Click the "Next" button.
• When "Monitor" is selected on the Channel Use screen, the Monitor Setting screen is displayed. (Advance to Step 14.)

![Monitor Setting](image)

• When “Monitor” is not selected on the Channel Use screen, the Stereo Link Configuration screen (same screen as in Step 15 on the next page) is displayed. (Advance to Step 16 on the next page.)

In the Output Monitor Setting section, set the D-2008SP's ID number to which the monitor output audio line is connected.

**Note**
There is no item to be set for the input monitor.
Step 15. Click the "Next" button.
The Stereo Link Configuration screen is displayed.

Checking the checkbox of a channel allows stereo link settings for that channel in 2-channel units.

[Stereo link functions]
• Performing Stereo Link settings for adjoining channels (such as Channels 1 and 2, 3 and 4, and 5 and 6) causes signal processing parameters for Compressor/Auto-Leveler, filter, and other functions to be linked. If a signal processing parameter for either channel is modified, the corresponding parameter of the other "linked" channel also simultaneously changes.
• The Stereo Link function can be independently set for input and output sides. Enable the Stereo Link setting when wishing to make the settings of both left and right channels identical, such as when a stereo input is received from a CD player or other stereo sound source and stereo output is sent to a tape recorder or similar stereo equipment.

[Stereo link setting restrictions]
• If you assign the bus from the stereo-linked input channel to the stereo-linked output channel, both left and right channels are simultaneously assigned. For example, when Input 1 is stereo-linked to Input 2, and Output 1 is linked to Output 2, if Input 1 is assigned to Output 1, Input 2 is also similarly assigned to Output 2. However, you cannot assign Input 1 to Output 2 or Input 2 to Output 1.
• Stereo-Link settings cannot be performed for the output channels that have employed the crossover function. Conversely, the stereo-linked channels cannot use the crossover function.
• The FBS function cannot be used for the stereo-linked bus channels.
Step 17. Click the "Next" button. The Filter Point Number Setting screen is displayed.

Step 18. Perform Filter Point Number Setting. Set the number of filters to be used for individual input and output channels.

Note
The number of available filters is limited. Confirm the available filter number on the screen. When more filters are needed, changing module mounting slots may solve this problem. (Refer to p. 16, "6-1. Module Setting.")

Step 19. Click the "Next" button. The FBS Setting screen is displayed.

Step 20. Perform FBS Setting. Select bus channels for FBS (Feedback Suppressor) assignment. Up to 4 channels can be assigned.
Step 21. Click the "Next" button.
The X-over Combination screen is displayed.

![X-over Combination Screen]

**Note**
To set the crossover function, proceed to **Step 22**. Otherwise, proceed to **Step 25** on the next page.

Step 22. Click the setting contents to perform the crossover combination settings.
Setting status is displayed on the right side of the screen.
When "2-way" is selected on a channel, its next channel is used together.
When "3-way" is selected on a channel, its next 2 channels are used together.
When "4-way" is selected on a channel, its next 3 channels are used together.

**Note**
Performing the crossover combination settings causes 1 or 2 output filter points on the corresponding channel to be used: 1 filter point is used when HPF or LPF is set, and 2 filter points when BPF (both HPF and LPF) is set.

**[2-way/2-channel setting example]**
Step 23. Click the "Next" button.
The X-over Slope screen is displayed.

Step 24. Tick the checkboxes for the crossover slope settings.
Setting status is displayed on the right side of the screen.

Note
The template created using the setting software for the D-901 Digital Mixer can be used.
When using the template, tick "Template" check box, then the button located on the right side of a checkbox becomes active. Click this button, and a dialog box for selecting the file is then displayed.
If you select the file and click the "Finish" button, the signal flow (see below) is displayed.

Step 25. Check to ensure that the setting is correct and click the "Finish" button.
The signal flow is displayed.
5.2. D-2012C Configuration Settings

Step 1. Select "Unit → Create New Unit..." from the menu. The Unit Configuration setting screen is displayed.

Step 2. Enter a unit name. Up to 20 alphanumeric characters can be used.

Step 3. Set Unit Type. Select the D-2012C Remote Console Unit as the Unit type to be created.

Step 4. Set the Console ID number by selecting it from the Combo box. (Setting range: ID1 – ID4)

Step 5. Click the "Finish" button. The Console view is displayed.
5.3. Unit Change or Deletion and Slot Information Confirmation

5.3.1. Deleting the unit

The unit that has been already created can be deleted only when the PC is not in communication with the unit.

Notes

• Deleting all the D-2008SP units when both the D-2008SP and D-2012C units have already been created simultaneously deletes the D-2012C as well.
• Deleting the D-2008SP with ID1 disables the interlock function to control other units within the system, and the control (see p. 84 and 109) by pressing the D-2012C's function key as well.

Step 1. Select "Unit → Delete Unit..." from the menu.
   The confirmation screen is displayed.

   ![Confirmation Screen]

   Note: The unit selected in the unit view (see p. 29) can be subject to deletion.

Step 2. Click the "OK" button.
   The unit is deleted.

5.3.2. Changing the unit configurations

The unit configuration that has been already created can be changed only when the PC is not in communication with the unit.

Select "Unit → Change Unit Configuration..." from the menu to display the I/O Setting screen. Unit configuration can be changed in the same procedures as for creating a new unit configuration.
5.3.3. Confirming the slot information

Select "Unit → Slot Information..." from the menu to display the Slot Information screen. The screen offers information on the module settings and the module status while the PC is in communication with the unit.

- **PC side ID:** Unit ID of the setting data on the PC
- **Slot No.:** Slot number of the module on the unit's rear panel
- **Module Settings:** Model of module stored in memory
- **Module Status:** Model of module inserted in unit

If the Module settings and Module status information on a slot do not match, the slot data is highlighted in red as shown below.

**Note**
Unless the Module settings and Module status information on all slots exactly match with each other, the unit does not operate correctly.
(For procedure, please refer to the next page.)
5.3.4. Changing the unit names

Select "Unit → Names..." from the menu to display the Name Setting screen. The Unit's name and Input/Output/Bus channel's names can be changed.

Notes
- Up to 20 alphanumeric characters can be used.
- To make the unit name blank, enter a space with the space key.
  Deleting the default name cannot set it blank. (The default name remains as it is.)
6. MAIN SCREEN AFTER COMPLETION OF UNIT CONFIGURATION

Menu (See p. 12.)

Main view (See p. 38 and 106.)

Unit view (See p. 29.), Connection status view (See p. 30.)

Memory view (See p. 31.)

Monitor view* (See p. 33.)

* Monitor view is displayed only when in online mode.
Please refer to p. 130 regarding putting the unit in online mode (when a PC is in communication with the unit).

Note
If communications error occurs between the D-2008SP and PC when bulk receiving (see p. 142) is executed, the monitor view screen will change as shown at right.
In such cases, initialize the setup data, or execute the bulk reception again after checking to see if all the units are connected correctly.
6.1. Unit View

The Unit View is located at the upper left of the main screen. Performing equipment configuration and system-related settings displays all units that make up the system. Selecting the unit display in the unit view switches the unit to be displayed in the main view. The unit is displayed in different color depending on its ID number.

<table>
<thead>
<tr>
<th>[D-2008SP]</th>
<th>[D-2012C]</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Unit type</td>
<td>(1) Unit type</td>
</tr>
<tr>
<td>Displays either the D-2008SP or the D-2012C.</td>
<td>Displays either the D-2008SP or the D-2012C.</td>
</tr>
<tr>
<td>(2) Unit ID</td>
<td>(2) Unit ID</td>
</tr>
<tr>
<td>Displays the unit's ID number (ID1 – 4).</td>
<td>Displays the unit's ID number (ID1 – 4).</td>
</tr>
<tr>
<td>(3) Unit name</td>
<td>(3) Unit name</td>
</tr>
<tr>
<td>Displays the unit's name.</td>
<td>Displays the unit's name.</td>
</tr>
<tr>
<td>(4) IP address</td>
<td>(4) IP address</td>
</tr>
<tr>
<td>Displays the unit's IP address.</td>
<td>Displays the unit's IP address.</td>
</tr>
<tr>
<td>(5) Communication connection status</td>
<td>(5) Communication connection status</td>
</tr>
<tr>
<td>Indicates unit communication connection status.</td>
<td>Indicates unit communication connection status.</td>
</tr>
<tr>
<td><img src="image" alt="Unconnected (offline state)" /></td>
<td><img src="image" alt="Unconnected (offline state)" /></td>
</tr>
<tr>
<td><img src="image" alt="Connected (online state)" /></td>
<td><img src="image" alt="Connected (online state)" /></td>
</tr>
<tr>
<td><img src="image" alt="Cooling fan failure detected in connected status (D-2008SP only)" /></td>
<td><img src="image" alt="Cooling fan failure detected in connected status (D-2008SP only)" /></td>
</tr>
<tr>
<td><img src="image" alt="Communication failure" /></td>
<td><img src="image" alt="Communication failure" /></td>
</tr>
<tr>
<td><img src="image" alt="Confirm network connections" /></td>
<td><img src="image" alt="Confirm network connections" /></td>
</tr>
<tr>
<td>(6) CobraNet status (D-2008SP only)</td>
<td>(6) CobraNet status (D-2008SP only)</td>
</tr>
<tr>
<td><img src="image" alt="CobraNet PRIMARY LINK" /></td>
<td><img src="image" alt="CobraNet PRIMARY LINK" /></td>
</tr>
<tr>
<td>Lights while CobraNet communications are being performed via the primary port.</td>
<td>Lights while CobraNet communications are being performed via the primary port.</td>
</tr>
<tr>
<td><img src="image" alt="CobraNet SECONDARY LINK" /></td>
<td><img src="image" alt="CobraNet SECONDARY LINK" /></td>
</tr>
<tr>
<td>Lights while CobraNet communications are being performed via the secondary port.</td>
<td>Lights while CobraNet communications are being performed via the secondary port.</td>
</tr>
<tr>
<td><img src="image" alt="CobraNet error" /></td>
<td><img src="image" alt="CobraNet error" /></td>
</tr>
<tr>
<td>Communication failure status</td>
<td>Communication failure status</td>
</tr>
<tr>
<td><img src="image" alt="None" /></td>
<td><img src="image" alt="None" /></td>
</tr>
<tr>
<td>CobraNet module not installed.</td>
<td>CobraNet module not installed.</td>
</tr>
<tr>
<td>(7) Word clock synchronization status (D-2008SP only)</td>
<td>(7) Word clock synchronization status (D-2008SP only)</td>
</tr>
<tr>
<td>Indicates word clock synchronization mode.</td>
<td>Indicates word clock synchronization mode.</td>
</tr>
<tr>
<td><img src="image" alt="Internal synchronization" /></td>
<td><img src="image" alt="Internal synchronization" /></td>
</tr>
<tr>
<td><img src="image" alt="CobraNet" /></td>
<td><img src="image" alt="CobraNet" /></td>
</tr>
<tr>
<td><img src="image" alt="External synchronization" /></td>
<td><img src="image" alt="External synchronization" /></td>
</tr>
<tr>
<td><img src="image" alt="Failure" /></td>
<td><img src="image" alt="Failure" /></td>
</tr>
<tr>
<td>(Superimposed over one of the above three to indicate irregularities.)</td>
<td>(Superimposed over one of the above three to indicate irregularities.)</td>
</tr>
<tr>
<td><img src="image" alt="Offline state" /></td>
<td><img src="image" alt="Offline state" /></td>
</tr>
<tr>
<td>(8) Console link group (D-2012C only)</td>
<td>(8) Console link group (D-2012C only)</td>
</tr>
<tr>
<td><img src="image" alt="Console link group" /></td>
<td><img src="image" alt="Console link group" /></td>
</tr>
<tr>
<td>Displays the console link group number (1 – 4).</td>
<td>Displays the console link group number (1 – 4).</td>
</tr>
<tr>
<td>(The group number is identical to D-2012C's unit ID number.)</td>
<td>(The group number is identical to D-2012C's unit ID number.)</td>
</tr>
</tbody>
</table>
6.2. Connection Status View

Clicking the connection status tab at the upper left of the main screen at the time of connection displays the connection status view. Connection status between the units can be confirmed.

The above view displays the connection status described below at the crosspoint between each unit.

- : Unconnected (or not connectable)
- : Connected
- : Communication error
- : Unknown state (Status cannot be obtained due to connection failure between the PC and related units)

If a communication error occurs on any of the unit, "Connection Status" tab name will be shown in white on red background.
6.3. Memory View

The memory view is located at the lower left of the main screen. It displays the preset memory (see p. 147) names and the preset memory numbers being currently selected. It is possible to recall preset memories and also to write data into the preset memories. The panel can be opened or closed by clicking the Memory List Panel Open/Close button. When the memory list panel is open, the cross-fade time is also displayed.

[Memory list panel closed:]

- It displays the preset memory names and the preset memory numbers being currently selected.
- To recall the Preset Memory, use the Up and Down buttons to display the memory number to be changed, then click the "Change" button. The menu bar can also be used to recall. (See p. 147, "Recalling the Preset Memory.")
- Editing the recalled Preset Memory enables the "Trash" button display. Clicking the "Trash" button discards the data in edit and recalls the original data.
- To write data into Preset Memory, use the Up and Down buttons to display the preset memory number to be stored, then click the "Store" button. The menu bar can also be used to write. (See p. 147, "Writing Data into the Preset Memory.")
- The Change Safe group indication shows the Change Safe groups to which the selected preset memory belongs. This indication appears only when the Change Safe function is enabled. (Refer to p. 126.)
• The currently selected Preset Memory is displayed in red in the memory list.

• To recall a preset memory, click the corresponding preset memory name in the memory list and click the "Change" button. Preset Memory can also be recalled by using the Up and Down buttons to display the preset memory number or double-clicking the preset memory name to be changed. The menu bar can also be used to recall. (See p. 147, "Recalling the Preset Memory.")

• Editing the recalled Preset Memory enables the "Trash" button display. Clicking the "Trash" button discards the data in edit and recalls the original data.

• To write data into the preset memory, click the corresponding preset memory name and click the "Store" button. The menu bar can also be used to write. (See p. 147, "Writing Data into the Preset Memory.")

• The Change Safe group indication shows the Change Safe groups to which the selected preset memory belongs. This indication appears only when the Change Safe function is enabled. (Refer to p. 126.)

* For the crossfade time, see p. 148.
6.4. Monitor View

Monitor view is displayed at the lower left corner of the main screen when in online mode. It is displayed only when the unit selected in the unit view has been set to "Monitor."

Monitor audio signals are sent to the monitor bus between the D-2008SP and D-2012C, and also sent to the output destination set as follows.

- Select "Monitor" for the output channel to be used as monitor in the Output Channel Use setting on the Channel Use screen. (See p. 17.)
- Designate the D-2008SP’s ID number to which monitor audio output is sent in the Output Monitor Setting on the Monitoring Setting screen. (See p. 19.)

To monitor the audio signals from the unit with different ID number assigned, perform settings as shown below in addition to above settings.

- Select "Monitor" for the input channel to be used as monitor in the Input Channel Use setting on the Channel Use screen. (See p. 17.)
- Connect the audio signal line. (See separate Installation manual, "Audio Monitor Line Connection When Multiple Units Are Connected.")

Monitoring points are fixed for individual channel areas as follows:

<table>
<thead>
<tr>
<th>Channel area</th>
<th>Monitoring point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio In, CobraNet In</td>
<td>Pre-fader</td>
</tr>
<tr>
<td>Audio Bus</td>
<td>After-fader</td>
</tr>
<tr>
<td>Ext. In, CobraNet Bus</td>
<td>Pre-fader</td>
</tr>
<tr>
<td>Audio Out, CobraNet Out</td>
<td>After-fader</td>
</tr>
</tbody>
</table>

Notes

- Multiple channels can be simultaneously selected (mixing) and output for monitoring.
- Monitor selection statuses cannot be stored.

[Monitor Channel Selection from the Flow View]

Audio can be assigned to the monitor output by selecting the monitor button visible in the flow view meter box, which shows monitor outputs. Audio cannot be monitored at the point where the monitor button is not displayed on the box.
6.5. Level Monitor View

6.5.1. When the D-2008SP is selected

The entire level meter at the meter display points and status for the contact input/output module can be displayed on the level monitor view. (It is not displayed when the contact input/output module is not connected.)

The level monitor view is superimposed over the flow view in online mode only. (The image differs depending on the screen display settings of the PC used.)

Clicking each Meter box (Meter, PF Meter, or AF Meter) in the Input/Bus/Output flow view (see p. 38) displayed in the Main view causes the module corresponding to the selected box to be shown enclosed in a blue frame.

All level meters for the selected channel area are simultaneously displayed depending on the level area selected using the Switching tab (3).

A floating display can also be enabled by selecting "View → Level Monitor View... → Floating."

Selecting "View → Level monitor view → Split" from the menu causes other level areas of the same unit to be displayed simultaneously.

[Level monitor view at the time of Level meter display]

(1) Level meter
(2) Channel number display
  Displays each channel number.
(3) Switching tab
Switches between each level area and contact input/output status. Level meters can be displayed for the listed level areas.

<table>
<thead>
<tr>
<th>Level area</th>
<th>(Example) Level area: Audio In (PFL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio In (PFL)</td>
<td>Channel area</td>
</tr>
<tr>
<td>CobraNet In (PFL)</td>
<td>Level meter position</td>
</tr>
<tr>
<td>Audio Bus (PFL)</td>
<td></td>
</tr>
<tr>
<td>Audio Bus (AFL)</td>
<td></td>
</tr>
<tr>
<td>Ext. In Bus (PFL)</td>
<td></td>
</tr>
<tr>
<td>Ext. In Bus (AFL)</td>
<td></td>
</tr>
<tr>
<td>CobraNet Bus (PFL)</td>
<td></td>
</tr>
<tr>
<td>CobraNet Bus (AFL)</td>
<td></td>
</tr>
<tr>
<td>Audio Out (AFL)</td>
<td></td>
</tr>
<tr>
<td>CobraNet Out (AFL)</td>
<td></td>
</tr>
<tr>
<td>Audio Out (TGL)</td>
<td></td>
</tr>
</tbody>
</table>

Note
The level meter positions are expressed in the following abbreviations.
PFL: Pre-fader level
AFL: After-fader level
TGL: Total gain level

[Level monitor view at the time of contact input/output status display]

(1) Contact input
(2) Contact output
(3) Slot and module display
(4) Contact number
(5) Contact information
(6) Contact status

: Make
: Break
6.5.2. When the D-2012C is selected

When in online mode, all level meters for fader layer channels (see p. 122) selected at the D-2012C are simultaneously displayed.

[Level monitor view]

(1) Level meter

(2) Motorized fader/rotary encoder number display

(3) Fader layer display tab
    Displays the currently selected fader layer.

Note
    Layers cannot be switched through operation of this screen.

6.6. All Mute View

In this view, all the output channels in the system can be muted simultaneously. The All Mute view is active only when online, and its status cannot be stored in a file. The display can be switched between showing and hiding views from [View → All Mute View → Show/Hide] on the menu. The All Mute function can be turned on or off from [View → All Mute View → All Mute] on the menu.

All Mute: ON
    All the outputs of all units are muted.

All Mute: OFF
    Each output is subject to its mute setting, which can be confirmed on the Mute view (see p. 83).
6.7. Routing Monitor View

In the Routing Monitor view, double-clicking the channel box displays the signal routing from the box. For instance, when the input channel box is double-clicked, all the assigned busses and all output channels assigned to each bus are displayed in Tree view. The channel belonging to the selected box in the Routing Monitor view is a selected channel. To change the selected channel, double-click other channel. The display can be switched between showing and hiding views from [View → Routing Monitor View → Show/Hide] on the menu.

(1) **Level meter**
Indicates the signal level corresponding to the selected channel at the points below.
- Input channel: Pre-fader
- Bus channel: Pre-fader and after-fader
- Output channel: After-fader

(2) **Channel box**
The channel information is displayed in the box. The selected channel is shown with its channel box in a red frame.

(3) **Expand/collapse button**
Expands or collapses the tree view for the assigned channel boxes.

(4) **Selected channel indication**
Indicates the selected channel.
7. D-2008SP FUNCTION SETTINGS

Selecting the D-2008SP to be set in the unit view displays the flow or matrix view in the main view.

7.1. Flow View

The flow view displays the unit's signal processing images expressed with functional boxes and input-to-output signal flows.

Selecting the Input, Bus or Output tab displays the details for each channel.

Right-clicking on the function boxes in the signal flow image enables the following operations.

Copy and paste can also be performed by dragging and dropping the box.

Copy: Copies the value set for the designated function box to the clipboard.
Paste: Pastes the data in clipboard to the designated function box.
Initial value: Initializes the value set for the function box.

Notes
- Above operations cannot be performed for the Meter box.
- Above operations can be performed only in offline mode for the FBS box.
- There are limitations to the operation on the Module box as shown in the table below.

<table>
<thead>
<tr>
<th>Model</th>
<th>Copy</th>
<th>Paste</th>
<th>Initial value</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-921, D-2000AD1</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>D-922, D-923AE</td>
<td>✗</td>
<td>✗</td>
<td>✗</td>
</tr>
<tr>
<td>D-936R, D-937SP</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

✓: Operable  ✗: Inoperable
7.1.1. Input flow view

In this flow view, input-related Module, Trim, Filter, C/L, Automix, Meter and Fader boxes are arranged side by side. Audio In, Ext In and CobraNet In channel areas are also displayed.

- Channel information

- Channel area
  - Stereo/monaural display
  - Channel name

- Channel number
- Slot number
- Module type

Change safe group (displayed only when the Change Safe function is enabled)

There are three types of channel areas:

Audio In: Audio In
Ext. In: Ext. In
CobraNet In: CobraNet In
7.1.2. Bus flow view

In this flow view, bus-related Delay, Sub In Mix, FBS, PF Meter, Fader, and AF Meter boxes are arranged side by side. Audio Bus, Ext In and CobraNet Bus channel areas are also displayed.

• Channel information

There are three types of channel areas:

- Audio Bus
- Ext. In
- CobraNet Bus
7.1.3. Output flow view

In this flow view, output-related Fader, Meter, Xover, Filter, Comp, Delay, and Meter boxes are arranged side by side. Audio Out and CobraNet Out channel areas are also displayed.

• Channel information

There are two types of channel areas:

: Audio Out

: CobraNet Out
7.2. Matrix View

Clicking Input Matrix or Output Matrix tab displays the Matrix view, allowing settings of assignment and cross point gains between the input/output channels and buses.

7.2.1. Input Matrix view (Bus assignment and crosspoint gain settings)

Assigns Audio In or CobraNet In channels to the Audio Bus channels.

- indicates input and output signal routings. Dark mark represents cross points for which the cross point gain is set to –1 dB or less.
- A blue, thicker frame indicates the crosspoint being selected.
- A red, thicker frame indicates the selected crosspoint with the focus, at which signal level is indicated by the fader.
- Two or more points can be selected by dragging the mouse, or clicking the mouse while holding down the Ctrl key or Shift key.
- The selected crosspoint turns on and off as it is double-clicked or the keyboard space bar is pressed.
- Switching the crosspoint ON/OFF and changing the Change Safe group are possible from the right-click menu appearing on the crosspoint.
- Switching the crosspoints ON/OFF and changing the Change Safe groups simultaneously in a column or row are possible from the right-click menu appearing on the numeral that represents the channel number.
- Bus assignments and cross point gains between two stereo channels are linked and operated.
(See p. 20, "Stereo link functions" and "Stereo link setting restrictions.")
(1) Fader
Selecting the active crosspoint allows the fader to indicate the signal level at that crosspoint. When two or more crosspoints are selected, the fader indicates the signal level at the active crosspoint with the focus (indicated by a red, thicker frame).
Different signal levels at the selected crosspoints can be changed simultaneously to the same level by moving this fader up or down.

(2) Level setting button [Level (dB)]
If you select the Crosspoint set to on, the corresponding Level setting button "Level (dB)" is displayed.
Indicates the signal level at the selected Crosspoint by means of numerical values.
If you click this button, a dialog for level setting is displayed, enabling you to set the level by directly entering a numerical value.
Setting Range: –∞, –69 to 0 dB
You can also change the level in 1 dB units with the Up and Down buttons located on the right side.

(3) Channel name display button
Clicking this button displays the name of each channel.
Clicking this button again reverts to the original display.

(When channel names are displayed)
(4) **Numerical value indication selection button**
Indicates the level setting at each Crosspoint by means of numerical values if this button is clicked. Clicking this button again reverts to the original display.

(Displayed in numerical form)

(5) **Safe group display button**
Appears when the Change Safe function is enabled. Clicking this button displays the Change Safe groups assigned to each crosspoint.

**Tip**
If group marks are hard to confirm on the display because they overlap with the crosspoint marks, it is recommended to switch the display to the numerical form.
7.2.2. Output Matrix view (Output assignment and crosspoint gain settings)

Assigns Audio Bus, Ext. In, or CobraNet Bus channels to the Audio Out or CobraNet Out channels.

**Note**
The CobraNet Bus cannot be assigned to the CobraNet Out.

**Tip**
Explanations, operations, and setting methods for this view are the same as those for the Input Matrix view. (Refer to p. 42 – 44.)
7.3. Contents View

Clicking the box in the flow view causes the corresponding contents view to be displayed under the flow view. The box can also be selected by arrow key operation while holding down the Ctrl key on the keyboard. When two or more modules are displayed, the selected module is shown in red frame in the Contents view.

The Resize handle (1), View Type Selection button (2) and Docking/Floating Display Selection button are located at the top of the Contents view.

(1) **Resize handle**

Dragging this handle while the docking view is displayed allows the height of the contents view to be changed.

(2) **View type selection button**

Switches the contents view between the fixed display and the enlarged/reduced display.

(3) **Docking/Floating display selection button**

Switches the contents view display mode between the docking display and the floating display.
7.3.1. Module view

The "Module" of the Input Flow view represents the connector for the module an audio input channel has been assigned to.

**Microphone/line Input module view (Available only when the D-921E, D-921F, or D-2000AD1 is used)**

Click the "D-921" or "D-2000AD1" box displayed on the input slot in the Flow View. The Microphone/Line Input Module View is then displayed on the Contents View. The module box and contents view displays are interlocked, allowing the same setting to be performed from either of the two displays.

[Module box (when the D-921E or D-921F is used)]

[Microphone/line Input module view (when the D-921E or D-921F is used)]

[Module box (when the D-2000AD1 is used)]

**Note**
Parts (1) through (3) are explained on the next page.
[Microphone/line Input module view (when the D-2000AD1 is used)]

Note
The D-2000AD1 module has 4-channel inputs, however the display is divided into two separate sections, each consisting of 2 channels.

(1) Phantom power ON/OFF button [Phantom Power]
Displays the ON/OFF setting status of the phantom power supply for the selected channel. Click this button to turn on or off the phantom power. (Always set to OFF when LINE is selected with the PAD button.)

Note
If the module is used for monitor input, the button is fixed to "OFF."

(2) PAD button [PAD]
Displays the PAD settings of the selected channel. You can select the setting value from the pull-down menu if you click this button.

Note
If the module is used for monitor input, the button is fixed to "LINE +4 dB."

(3) Slot/Connector No. display
Displays the number of each slot and connector into which a module has been inserted.

Handling precautions when D-2000AD1 is used

- Be sure to turn off the phantom power (+48 V) when using an unbalanced microphone or equipment such as a CD player or effecter other than a microphone. As doing otherwise may cause damage to the unit.
- To insert or remove a condenser microphone that requires external power source, turn down the fader of the corresponding channel, turn off its channel and the phantom power (+48 V), then wait at least 1 minute before inserting or removing. As doing otherwise may cause damage or failure to this module and microphone.
- Noise may be produced when or after the phantom power (+48 V) is turned on or off. Be sure to turn on or off the phantom power (+48 V) after turning down the fader of the corresponding channel and turning off the channel. Also, never operate the fader nor turn on and off the channel for 1 minute after turning on or off the phantom power (+48 V).
- Current consumption of the phantom power supply must be 5 mA or less per channel.
Click the "D-923AE" or "D-937SP" box displayed on the input slot in the Flow View. The Digital Input Module View is then displayed on the Contents View.
Channel status is displayed in the module box, which is interlocked with the Channel Status display in the Contents view.

Note
Parts (1) through (3) are explained on the next page.
(1) Channel status indication [Status]
Displays the input signal status of the selected channel.

<table>
<thead>
<tr>
<th>Display</th>
<th>Input signal status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock</td>
<td>Normal</td>
</tr>
<tr>
<td>Unlock</td>
<td>No cable connected or equipment power not</td>
</tr>
<tr>
<td></td>
<td>turned on</td>
</tr>
<tr>
<td>Non Audio</td>
<td>Not an audio signal</td>
</tr>
<tr>
<td>Non PCM</td>
<td>Not PCM data</td>
</tr>
<tr>
<td>DTS CD</td>
<td>DTS CD</td>
</tr>
</tbody>
</table>

The indications are shown by white text in green frame for the LOCK status, and white text on red background for the error status. Module boxes are also displayed in the same manner.

: LOCK status

: Error status

Note
If the module is used for monitor input, the status indication cannot be displayed.

(2) Sampling frequency indication [Fs (Hz)]
Displays the sampling frequency of the selected channel.

(3) Pre-emphasis ON/OFF status [Pre emphasis]
Displays the pre-emphasis ON/OFF status of the selected channel.
  - Non: Pre-emphasis not applied.
  - Detect: Pre-emphasis applied.

(4) D-937SP module input selection (Line selection) [1, 2, 3, 4] (Only when D-937SP is used)
Displays the selected status of the D-937SP module's inputs 1 – 4. The selected status is indicated by the symbol. Double-clicking the input indication switches the selection status between "selected" and "unselected."

Note
Unlike the MIX ALL mode of the D-936R, only one input can be selected.
Stereo Input module view (Available only when the D-936R is used)

Click the "D-936R" box displayed on the input slot in the Flow View. The Stereo Input Module View is then displayed on the Contents View.

The module's operation mode is displayed in the module box, which is interlocked with the Mode Display button of the Contents view.

[Module box]

(1) Mode indication button
Displays the operation mode of the module.
- MIX ALL mode: Mixes 4 (stereo) line inputs. Any individual stereo input can also be disabled.
- SELECT mode: Selects a single (stereo) line input. Trim settings can be performed for individual line inputs.

You can select the mode from the pull-down menu if you click this button.

(2) ON/OFF control [1, 2, 3, 4]
- Displays the ON/OFF setting status of the module's inputs 1 – 4. The input indicated by the symbol is set to ON.
- The input toggles between "ON" and "OFF" each time it is double-clicked.
- The thick, red frame on the ON/OFF control indicates the selected input.
- Each of Inputs 1 – 4 can be individually set to ON or OFF when in MIX ALL mode.
- Any one of inputs 1 – 4 can be set to ON when in SELECT mode.
- Only input 1 is set to ON if mode is switched from MIX ALL to SELECT mode.
- All inputs 1 – 4 are set to ON if mode is switched from SELECT to MIX ALL mode.
7.3.2. Trim view (Input trim settings)

Clicking the trim box on the Input Flow view displays the Trim view in the Contents view. The trim box contains the Polarity Reverse and Gain Display buttons. The Trim Box and Contents View displays are interlocked, allowing the same setting to be performed from either of the two.

[Trim box]

(1) Fader
You can change the signal level of each channel by moving this fader up and down.

(2) Gain indication button [Gain (dB)]
Indicates each channel signal level by means of numerical values. If you click this button, a dialog for gain setting is displayed, enabling you to set the gain by directly entering a numerical value. (Setting range: –15 to +15 dB)
You can also change the gain in 0.1 dB units with the Up and Down buttons located on the right side.

(3) Polarity reverse button [Polarity]
Displays each channel's polarity. Clicking this button permits the polarity to be reversed.

(4) Channel number display
Displays each channel number.
7.3.3. Input filter view (High-pass filter/equalizer/low-pass filter settings)

Clicking the filter box on the Input Flow view displays the Input filter view in the Contents view. In the Filter box, the number of filters that can be used and an overview of set filter characteristics are displayed. In the Input Filter box, the filters available are preset and the filter types cannot be changed.

[Filter box]

![Filter box diagram]

[Input filter view]

![Input filter view diagram]

(Displayed in tabular form)

![Tabular view diagram]

Note
Parts (1) through (14) are explained on the next page or later.
(1) Filter control area

(2) Minimum frequency adjustment buttons
Increase or decrease the lower frequency limit on a graduated scale.

(3) Filter point list

(4) Filter point
Circles on the filter control area indicate operable filter points. Yellow circles refer to the selected filter points.
- : High-pass filter (HPF)
- : Parametric equalizer (PEQ)
- : Low-pass filter (LPF)
To change the gain (only for PEQ) and frequency, drag the filter point.
When a white circle is displayed on the left of the filter point, click and drag the white circle up and down. The Q value of the selected filter point can then be changed.

(5) Maximum frequency adjustment buttons
Increase or decrease the upper frequency limit on a graduated scale.

(6) Maximum amplitude adjustment buttons
Increase or decrease the upper amplitude limit on a graduated scale.

(7) Filter type indication button
Displays the type of filter.

(8) Frequency indication button [Freq. (Hz)]
Displays the frequency of the selected filter point.
If you click this button, a dialog for frequency settings is displayed, enabling you to set the frequency by directly entering a numerical value. (Setting range: 20 Hz – 20 kHz)
You can also change the frequency in 1/24 octave units (step width can be changed with the Option button) using the Up and Down buttons located on the right side.

(9) Gain indication button [Gain (dB)] (only PEQ)
Displays the gain of the selected filter point. If you click this button, a dialog for gain setting is displayed, enabling you to set the gain by directly entering a numerical value. (Setting range: –15 to +15 dB)
You can also change the gain in 0.5 dB units (can be changed to 0.1 dB units with the Option button) using the Up and Down buttons located on the right side.

(10) Q indication button
Displays the Q value of the selected filter point.
Clicking this button permits setting values to be selected from the pull-down menu.

(11) Filter ON/OFF button
Displays the ON/OFF setting status of each selected filter. The ON/OFF setting can be changed by clicking this button.

(12) Table display button
If this button is clicked, the filter control area is displayed in tabular form. Clicking this button again reverts to the original graphic display.
(13) Option button
Clicking this button causes the following pull-down menu to appear.

Scale...  :  Changes the scale.
Q-Display:  The method to display Q can be changed. (Only available for parametric equalizers.)
Fine Resolution:  You can change the frequency step width if "Frequency" is selected, and the gain step width if "Gain" is selected.

(14) Minimum Amplitude Adjustment buttons
Increase or decrease the lower amplitude limit on a graduated scale.
7.3.4. Comp/leveler view (Compressor/Auto-Leveler function settings)

Clicking either the C/L box in the Input Flow view or the Comp box in the Output Flow view displays the Comp/Leveler view in the Contents view.
Compressor or Auto-Leveler mode can be selected for input channels.
Output channels have the Compressor function but not Auto-Leveler function.
The box contains a mode display and an ON/OFF button for each box.
The box and Content view are interlocked, allowing the same setting to be performed from either of the two.

For Auto-Leveler function, see p. 150.

[C/L box (when Compressor mode is selected) and Comp box]

Compressor mode display

[9]

[C/L box (when Auto-leveler mode is selected)]

Auto-leveler mode display

[9]

Compressor function settings

The setting screens used here are examples for the input channel.
In output channel, there are no indications/settings related to the Auto-Leveler function.

Note
Parts (1) through (9) are explained on the next page or later.
Clicking the "Comp All" tab causes the setting screen for all channels set to Compressor mode to appear.

(1) Mode selection button [Comp/Leveler] (Available only for input channel)
Displays the Compressor/Auto-Leveler mode. Mode selection can be performed for individual channels. All input channels are set to Compressor mode by default. Clicking this button causes the "Auto-Leveler mode" or "Compressor mode" to be selected from the pull-down menu.

Note
At the time of mode selection, each parameter of compression and auto-leveler functions for the channel returns to the initial value.

(2) Input/output level meter
Displays the input/output signal, the reduction (how much the compressor has worked) and the threshold levels by way of the following bar graph when the unit is operating during communications between the unit and the PC.
If Stereo Link function is set to channels, the level meters of both left and right channels are simultaneously displayed.

### (3) Comp threshold button [Threshold (dB)]
Displays the compression threshold level for each channel by means of numerical values. If you click this button, a dialog for threshold level setting is displayed, enabling you to set the level by directly entering a numerical value. (Setting range: –20 to +20 dB) You can also change the level in 1 dB units with the Up and Down buttons located on the right side.

### (4) Comp ratio button [Ratio]
Displays the compression ratio for each channel by means of numerical values. If you click this button, setting values can be selected from the pull-down menu. The Up and Down buttons located on the right side can also be used to change the value.

### (5) Knee type button [Knee Type]
Displays the compressor knee type for each channel. If you click this button, setting values can be selected from the pull-down menu. The Up and Down buttons located on the right side can also be used to change the value.

Select one of the following 3 types of setting values: Hard, Soft1 and Soft2.

- **Hard**: Called "Hard knee characteristics," this compresses the signal level immediately when it exceeds a set threshold.
- **Soft1/Soft2**: The signal level is gradually compressed before it reaches the threshold, and the ratio gradually increases to the set ratio until the level exceeds the threshold by a certain degree. If the level greatly exceeds the threshold, these values coincide with hard knee characteristics. Soft2 provides gentler characteristics than Soft1 does.

### (6) Comp attack button [Attack (ms)]
Displays the compressor attack time for each channel by means of numerical values. If you click this button, setting values can be selected from the pull-down menu. The Up and Down buttons located on the right side can also be used to change the value.

### (7) Comp release button [Release (ms)]
Displays the compressor release time for each channel by means of numerical values. If you click this button, setting values can be selected from the pull-down menu. The Up and Down buttons located on the right side can also be used to change the value.

### (8) Comp gain button [Gain (dB)]
Displays the compressor gain for each channel by means of numerical values. If you click this button, a dialog for compressor gain settings is displayed, enabling you to set the gain by directly entering a numerical value.

Setting range: \(-\infty\) to +10 dB
You can also change the gain in 1 dB units with the Up and Down buttons located on the right side.
Auto-Leveler function settings (Available only for the input channel)

Clicking the "Leveler All" tab causes the setting screen for all channels set to Auto-Leveler mode to appear.

(9) Comp ON/OFF button [On/Off]
Displays the ON/OFF setting status of the compressor in each channel. Click this button to turn on or off each compressor.

(1) Mode selection button [Comp/Leveler]
Displays the Compressor/Auto-Leveler mode. Mode selection can be performed for individual channels. All input channels are set to Compressor mode by default. Clicking this button causes the "Auto-Leveler mode" or "Compressor mode" to be selected from the pull-down menu.

Note
At the time of mode selection, each parameter of Compressor and Auto-Leveler functions returns to the initial value.
(2) *Input/Output level meter*
Displays the input/output signal and the target levels by way of the following bar graph when the unit is operating during communications between the unit and the PC.

![Input/Output level meter diagram](image)

If Stereo Link function is set to channels, the level meters of both left and right channels are simultaneously displayed.

(3) *Auto-Leveler target level button [Target Level (dB)]*
Displays the Auto-Leveler's threshold level for each channel by means of numerical values. If you click this button, a dialog for threshold level setting is displayed, enabling you to set the level by directly entering a numerical value.
Setting Range: –20 to +10 dB
You can also change the level in 1 dB units with the UP and Down buttons located on the right side.

![Target Level Setting dialog](image)

(4) *Auto-Leveler max gain button [Max Gain (dB)]*
Displays the Auto-Leveler max gain for each channel by means of numerical values. If you click this button, a dialog for max gain setting is displayed, enabling you to set the level by directly entering a numerical value.
Setting Range: 0 to +20 dB
You can also change the level in 1 dB units with the UP and Down buttons located on the right side.

![Max Gain Setting dialog](image)

(5) *Auto-Leveler attack button [Attack (ms)]*
Displays the Auto-Leveler attack time for each channel by means of numerical values. If you click this button, setting values can be selected from the pull-down menu.
The Up and Down buttons located on the right side can also be used to change the value.

(6) *Auto-Leveler release button [Release (ms)]*
Displays the Auto-Leveler release time for each channel by means of numerical values.
If you click this button, setting values can be selected from the pull-down menu.
The Up and Down buttons located on the right side can also be used to change the value.

(7) *Auto-Leveler ON/OFF button [On/Off]*
Displays the ON/OFF setting status of the Auto-Leveler in each channel.
Click this button to turn on or off each Auto-Leveler.
7.3.5. Automix view (Auto-mixing Function* Settings)

Clicking the Automix box in the Input Flow view displays the Automix view in the Contents View, containing the AutomixGroup display, Gate ON/OFF button and Gate Status indicator. The box and Contents view displays are interlocked, allowing the same Gate ON/OFF setting to be performed from either of the two.

* For Auto-mixing function, see p. 150.

[Automix box]

Gate function settings

If you click the Automix box, the screen of the "GATE" tab is first displayed.

For Gate function, see p. 150.

Click the "Gate All" tab. The setting screen for all channels is then displayed.

Note
Parts (1) through (10) are explained on the next page or later.
(1) **Input/Output level meter**
Displays the input/output signal and the threshold levels by way of the following bar graph when the unit is operating during communications between the unit and the PC.

![Input/Output level meter diagram](image)

If the hysteresis is set, both open and close threshold levels are displayed.

If Stereo Link function is set for channels, the level meters of both left and right channels are simultaneously displayed.

(2) **Auto-mixing group setting button [Automix Group]**
Sets the auto-mixing group assignment to each channel. Clicking this button permits groups (A – D) to be selected from the pull-down menu. This setting can also be performed on the screen displayed by clicking [NOM] or [Ducker] tabs.
(3) **Gate threshold button [Gate Threshold (dB)]**
Displays the gate threshold level for each channel by means of numerical values. If you click this button, a dialog for threshold level setting is displayed, enabling you to set the level by directly entering a numerical value. (Setting range: –50 to +20 dB.) You can also change the threshold level in 1 dB units with the Up and Down buttons located on the right side.

(4) **Gate hysteresis button [Gate Hysteresis (dB)]**
Displays the gate hysteresis for each channel by means of numerical values. If you click this button, a dialog for hysteresis setting is displayed, enabling you to set the hysteresis by directly entering a numerical value.
Setting range: 0 to +10 dB
You can also change the hysteresis in 1 dB units with the Up and Down buttons located on the right side.

(5) **Gate depth button [Gate Depth (dB)]**
Displays the gate depth for each channel by means of numerical values. If you click this button, a dialog for depth setting is displayed, enabling you to set the depth by directly entering a numerical value.
Setting range: \(-\infty, -69\) to 0 dB
You can also change the depth in 1 dB units with the Up and Down buttons located on the right side.

(6) **Gate hold button [Gate Hold (ms)]**
Displays the gate holding time for each channel by means of numerical values. If you click this button, setting values can be selected from the pull-down menu. The Up and Down buttons located on the right side can also be used to change the value.

(7) **Gate attack button [Gate Attack (ms)]**
Displays the gate attack time for each channel by means of numerical values. If you click this button, setting values can be selected from the pull-down menu. The Up and Down buttons located on the right side can also be used to change the value.

(8) **Gate release button [Gate Release (ms)]**
Displays the gate release time for each channel by means of numerical values. If you click this button, setting values can be selected from the pull-down menu. The Up and Down buttons located on the right side can also be used to change the value.

(9) **Gate ON/OFF button [Gate On/Off]**
Displays the ON/OFF setting status of the Gate function for each channel. Click this button to turn on or off the Gate function.

(10) **Gate status indicator [Gate Close]**
Lights yellow when the gate operates (closes).
NOM attenuation function* settings

Clicking the "NOM" tab causes the NOM attenuation function setting screen for all channels to appear.

* For NOM attenuation function, see p. 150.

(1) Auto-mixing group setting button [Automix Group]
Sets the auto-mixing group assignment to each channel.
If you click this button, groups can be selected from the pull-down menu.
This setting can also be performed on the screen displayed by clicking "GATE," "Gate All," or "Ducker" tab.

(2) NOM attenuation ON/OFF button [NOM On/Off]
Displays the ON/OFF setting status of the NOM attenuation function for each channel. Click this button to turn on or off the NOM attenuation function.

(3) NOM attenuation button [NOM Attenuation]
Displays the NOM attenuation gain by means of numerical values. If you click this button, a dialog for NOM setting is displayed, enabling you to set the NOM attenuation gain by directly entering a numerical value.
Setting range: 0 – 20 (0 log₁₀NOM – 20 log₁₀NOM)
The Up and Down buttons located on the right side can also be used to change the value.
Ducker function* settings

Clicking the "Ducker" tab causes the Ducker setting screen for all channels to appear.

* For Ducker function, see p. 150.

(1) Auto-mixing group setting button [Automix Group]
Sets the Auto-mixing group assignment to each channel. If you click this button, groups can be selected from the pull-down menu. This setting can also be performed on the screen displayed by clicking "GATE," "Gate All," or "NOM" tab.

(2) Priority button [Ducker Priority Level]
Displays priorities for each channel. (1 – 8; 1: Highest, 8: Lowest) If you click this button, a dialog for setting priorities is displayed, enabling you to set priorities by directly entering a numerical value. The Up and Down buttons located on the right side can also be used to change the value.

(3) Ducker depth button [Ducker Depth (dB)]
Displays the Ducker depth for each channel by means of numerical values. If you click this button, a dialog for setting the depth is displayed, enabling you to set the depth by directly entering a numerical value. Setting range: $-\infty$, –69 to 0 dB You can also change the level in 1 dB units with the Up and Down buttons located on the right side.

(4) Ducker attack button [Ducker Attack (ms)]
Displays the Ducker attack time for each channel by means of numerical values. If you click this button, setting values can be selected from the pull-down menu. The Up and Down buttons located on the right side can also be used to change the value.

(5) Ducker release button [Ducker Release (ms)]
Displays the Ducker release time for each channel by means of numerical values. If you click this button, setting values can be selected from the pull-down menu. The Up and Down buttons located on the right side can also be used to change the value.

(6) Ducker ON/OFF button [Ducker On/Off]
Displays the ON/OFF setting status of the Ducker function for each channel. Click this button to turn on or off the Ducker function.
7.3.6. Fader view (Input/bus/output gain, input/bus/output VCA display, and input/bus/output group trim settings)

Clicking the Fader box in the Input/Bus/Output flow view causes the Fader view to be displayed in the Contents view with tab displays for each channel area and Channel On/Off button, Gain Display button, VCA Level indicator and Grouping Color displays visible. The box and Content view displays are interlocked, allowing the same channel ON/OFF and gain settings to be performed from either of the two.

[Fader box]

Channel ON/OFF button

Gain indication button

VCA level display

Grouping color display

[Fader view]

(1) Channel area selection tab [Fader All (channel area name)]

Switches channel areas.

(2) Display selection tab [Fader/VCA/Gr Trim]

Selects the Fader display, VCA display, or Group Trim display for channel area faders selected with the Channel Area Selection tab.
Input, Bus, and Output gain settings (Fader display)

Clicking the Fader box in the Input/Bus/Output flow view causes the faders for the corresponding channel area to appear in the fader-operated setting screen.

(1) Grouping button [Grouping]
Displays the channel grouping number assigned to each channel. Click this button and select "Grouping → Channel" to perform the channel group setting. If you move a fader of a grouped channel, the faders of other channels assigned the same group also move in synchronization with the first operated fader. The Group Trim gain (Gr Trim) is enabled when a group setting is performed, allowing the offset gain of each grouped channel to be set.

Notes
• The faders within the same channel area can be grouped.
• It is not possible to perform grouping with the different unit’s channels.
• The channel to be controlled by the VCA volume can be grouped as well. In this case, observe precautions for the channel group assignment. (Refer to p. 99, "VCA Module Setting screen.")
• When the Change Safe function is used, note the relation between the Change Safe group setting and the grouping number. (For details, refer to p. 126, "Change Safe Function Setting.")

(2) Group trim gain button [Gr Trim (dB)]
Displays the group trim gain set for each channel by means of numerical values. When channel group settings have been performed, if you click this button, a dialog for fader setting is displayed, enabling you to set the trim gain by directly entering a numerical value. The group trim gain setting performed in this dialog is interlocked with the group trim gain setting shown on the [Gr Trim] tab screen.
Setting range: $-\infty$ to $-79.9$ to $+10$ dB
You can also change the gain in $0.1$ dB units with the Up and Down buttons located on the right side.

(3) Level meter display
Indicates the after-fader level for the Audio Bus, Audio Out, and CobraNet Out channel areas, and the pre-fader level for other channel areas.

(4) Fader
Move the fader up or down to change the signal level of each channel. Double-clicking the mouse while holding down the Ctrl key sets the fader value to $0$ dB.
(5) Gain indication button [Fader (dB)]
Displays the level for each channel by means of numerical values. If you click this button, a dialog for fader setting is displayed, enabling you to set the level by directly entering a numerical value.
Setting range: $-\infty$, –69.9 to +10 dB
You can also change the gain in 0.1 dB units with the Up and Down buttons located on the right side.

(6) Channel ON/OFF button [On/Off]
Displays the channel ON/OFF status of each channel. Click this button to turn on or off the channel.

(7) Channel number display
Displays each channel number.

Input, Bus, and Output VCA displays
Clicking the "VCA" on the display selection tab displays VCA levels set by the faders. VCA values controlled by external equipment through VCA module settings are displayed. Unmodified VCA values are displayed as is (10.0).

Note
VCA volume cannot be adjusted from a PC.

(1) Fader
Displays the fader. It cannot be changed.

(2) VCA values
Displays the VCA values controlled by external equipment through VCA module settings. Displayed values cannot be changed.

(3) Channel number display
Displays each channel number.

(4) VCA operation indicator
Lights whenever any VCA fader points the VCA other than "10.0" (through state).
Input, Bus, and Output group trim settings (Group trim display)

Clicking the "Gr Trim" on the display selection tab displays the fader-operated Group Trim Gain setting screen for the corresponding channel area.

(1) Grouping button [Grouping]
Displays the channel group number assigned to each channel.
Click this button and select [Grouping → (Channel)] to perform the channel group setting.
If you move a fader of a grouped channel, the faders of other channels assigned the same group also move in synchronization with the first operated fader.
The Group Trim gain (Gr Trim) is enabled when a group setting is performed, allowing the offset gain of each grouped channel to be set.

(2) Group trim gain button [Gr Trim (dB)]
Displays the group trim gain set for each channel by means of numerical values.
When channel group settings have been performed, if you click this button, a dialog for gain setting displayed, enabling you to set the trim gain by directly entering a numerical value. The group trim gain setting performed in this dialog is interlocked with the group trim gain setting shown on the "Fader" tab screen.
Setting range: \(-\infty, -79.9\) to +10 dB

(3) Fader
When a group setting has been performed, each channel's group trim gain can be changed by moving the fader up or down.

(4) Channel number display
Displays each channel number.
7.3.7. Sub In Mix view

Clicking the Sub In Mix box in the Bus Flow view displays the Sub In Mix view in the Content view, which displays the Channel ON/OFF button and Gain Display button in the Sub In Mix box. The Sub In Mix box is used to directly mix the CobraNet inputs into the audio bus. Set the CobraNet input channels to be mixed for "CobraNetSubIn" in the CobraNet Channel Use settings (refer to p. 18). These are assigned to the audio bus in ascending order. The box display is interlocked with the Content view display, and the same Channel ON/OFF and gain settings can be performed from either of the two.

[Sub in Mix box]

(1) Channel ON/OFF button [On/Off]
Displays the Sub In Mix ON or OFF status. Click this button to turn on or off the Sub In Mix function.

(2) Fader
Moving this fader up or down allows the CobraNet input mix level to be changed. The CobraNet input channels that can be mixed are displayed in the channel information slot number.

(3) Gain display button
Indicates the CobraNet input mix level by means of numerical values.
If you click this button, a dialog for gain setting is displayed, enabling you to set the gain by directly entering a numerical value.
Setting range: \(-\infty \) to +10 dB
You can also change the gain in 0.1 dB units with the Up and Down buttons located on the right side.
7.3.8. Delay view (Delay function settings)

Clicking the Delay box in the Bus/Output flow view displays the Delay view in the Content view. The Delay box contains the Delay ON/OFF button and Delay Time display. The box display is interlocked with the Content view display, and the same Delay ON/OFF settings can be performed from either of the two.

1. Minimum variation unit selection button (Increments)
   Selects the minimum units of the delay time that can be changed with the Up and Down buttons.

2. Option button
   If you click this button, a delay option dialog is displayed and you can select the unit of distance displayed on the delay distance indication button from meters, inches, and feet. You can also set the temperature displayed on the delay distance indication button for distance calculation.

3. Delay time indication button [Time (ms)]
   Displays the delay time in each channel by means of numerical values. If you click this button, a dialog for delay time setting is displayed, enabling you to set the delay time by directly entering numerical values.
(4) Delay distance indication button [Distance (meters/inches/feet)]
Displays the delay distance in each channel by means of numerical values. If you click this button, a dialog for delay distance setting is displayed, enabling you to set the delay distance by directly entering a numerical value.

(5) Up/Down button
Changes the delay time in minimum variation units.

(6) Delay ON/OFF button [On/Off]
Displays the ON/OFF setting status of the delay function. Click this button to turn on or off the delay function.
7.3.9. FBS view (Feedback suppression function settings)

Clicking the FBS box in the Bus flow view causes the FBS View to be displayed in the Contents view. The number of usable filters and an overview of set filter characteristics are displayed in the FBS box.

(FBS box)

- Number of usable filters
- Overview of set filter characteristics

(Displayed in tabular form)

(1) Minimum frequency adjustment buttons
Increase or decrease the lower frequency limit on a graduated scale.

(2) Maximum frequency adjustment buttons
Increase or decrease the upper frequency limit on a graduated scale.
(3) **Maximum amplitude adjustment buttons**
Increase or decrease the upper amplitude limit on a graduated scale.

(4) **Dynamic mode button [DYNAMIC Mode]**
Dynamic mode is a function that suppresses the feedback in real time when it occurs.
Displays the ON/OFF setting status of the dynamic mode.
Click this button to turn on or off the mode.

(5) **Auto start button [AUTO Start]**
Auto mode is activated if this button is clicked while a connection is being established between the D-2008SP unit and a PC for communications. The D-2008SP automatically seeks the feedback points and performs filter settings for feedback suppression. Note that auto mode does not start when the filter number of the auto mode is set to "0." If this button is clicked during auto mode operation, the auto mode stops.

**Note**
During auto mode operation, the dynamic mode in all the FBS boxes for that unit remains suspended.

(6) **Filter number indication button [AUTO: DYNAMIC]**
Displays the number of filters for auto mode and dynamic mode. Up to 12 filters can be set in combination of both modes. Clicking this button causes the combination of filter numbers of the auto mode and dynamic mode to be selected from the pull-down menu.
Filters used for Auto and Dynamic modes are assigned to Auto mode followed by Dynamic mode in order of filter number as shown below.

**Example for "AUTO : DYNAMIC  7 : 5" (default setting)]]**

<table>
<thead>
<tr>
<th>Filter No.</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Auto mode</td>
<td>Dynamic mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Example for "AUTO : DYNAMIC  8 : 4"]**

<table>
<thead>
<tr>
<th>Filter No.</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Auto mode</td>
<td>Dynamic mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Even when the number of filters is changed, filters are not initialized.
For example, when filter assignment is changed from "AUTO : DYNAMIC  7 : 5" to "AUTO : DYNAMIC  8 : 4" (refer to the above setting examples), Filter 8 operation mode is switched to Auto mode, however, keeping the filter parameters once set by Dynamic mode operation.
The Filter parameters and Mode confirmation display remain unchanged as those for Dynamic mode till Auto mode is activated.

(7) **Clear dynamic button [Clear DYNAMIC]**
Clears the setting of the dynamic mode filter and returns it to the initial status.

(8) **Clear auto button [Clear AUTO]**
Clears the setting of the auto mode filter and returns it to the initial status.

(9) **Scale change button**
If you click this button, a dialog is displayed, enabling you to change the scale of the characteristics graphic chart.

![Scale Dialog](image)

(10) **Table indication button**
Displays the filter status display area in tabular form.

(11) **Minimum amplitude adjustment buttons**
Increase or decrease the lower amplitude limit on a graduated scale.
(12) Filter status indication area
Displays the characteristics of the current dynamic mode filters and auto mode filters. Each filter's setting value is displayed in tabular form.

(13) Filter number

---

**Feedback suppression function operations**

**[Suppressing acoustic feedback with a simple operation]**

**Step 1.** Set the volume controls of connected external equipment to the state in which they will actually be used. Establish connection between the unit and a PC for communication.

**Step 2.** Click the Auto start button in the FBS view to activate the Auto mode. All filters (12 bands) that suppress feedback are set after they are initialized.

**Notes**
- Auto mode cannot be initiated if the number of Auto mode filters is set to 0.
- Large sounds are produced during Auto mode operation.
- During auto mode operation, the dynamic mode in all the FBS boxes for that unit remains suspended.
- Setting takes about 1.5 minutes. (This may differ depending on the unit installation circumstances.)
- No keys can be used during Auto mode operation. Click the Auto start button again to interrupt setup operations.

**[Settings to be performed as required]**

**Step 3.** Set the Dynamic mode or the number of filters in the FBS view as required.

**Notes**
- When the number of filters to be used for the Auto and Dynamic modes have been changed, reactivate the Auto mode.
- Take care when executing filter initialization, as feedback may occur.
- It is recommended that the Auto mode be reset when the equalizer setting value has been changed, because the feedback points may change.
7.3.10. Xover view (Crossover function settings)

Clicking the Xover box in the Output flow view causes the Xover view to be displayed in the Contents view. An overview of filter characteristics and a polarity reverse button are displayed in the Xover box.

[Xover box]

: When LPF  : When HPF  : When BPF

Note: A polarity reverse button appears in the upper right corner of each box.

Crossover function settings

The screen of the "Xover" tab is first displayed if the Xover box is clicked.

The indication displayed at the upper right of the screen changes depending on the type of selected filter.

[When "12 dB Variable-Q" or "18 dB Variable-Q" is selected]

[When "24 dB Variable-Q" is selected]
(1) Minimum frequency adjustment buttons
Increase or decrease the lower frequency limit on a graduated scale.

(2) Filter control area

(3) Filter points
A circle on the filter control area indicates the operable filter point. A yellow circle indicates the selected filter point.

- When selected, : When not selected: High-pass filter
- When selected, : When not selected: Low-pass filter
- When selected, : When not selected: Gain control

You can change the cut-off frequency of the selected filter point if you click and drag the low-pass or high-pass filter point left and right.
To change the gain of the selected filter point, click and drag the gain control point up and down. When a white circle is displayed on the right or left side of the filter point, if the white circle is clicked and dragged up and down, the Q value of the selected filter point can be changed.

(4) Maximum frequency adjustment buttons
Increase or decrease the upper frequency limit on a graduated scale.

(5) Maximum amplitude adjustment buttons
Increase or decrease the upper amplitude limit on a graduated scale.
(6) **Filter type indication button**
Displays the type of filter of the selected filter point.
If you click this button, the filter type can be selected from the pull-down menu.

(7) **Frequency indication button [Freq. (Hz)]**
Displays the frequency of the selected filter point.
If you click this button, a dialog for frequency setting is displayed, enabling you to set the frequency by directly entering numerical values.
Setting range: 20 Hz – 20 kHz
You can also change the frequency setting with the Up and Down buttons located on the right side.

(8) **Q/Q2 indication button ("Q2" is available only when "24 dB Variable-Q" is selected.)**
Displays the Q value of the selected filter point.
If you click this button, a setting value can be selected from the pull-down menu.

(9) **Gain indication button [Gain (dB)]**
Displays the gain of the selected gain control point.
If you click this button, a dialog for gain setting is displayed, enabling you to set the gain by directly entering numerical values.
Setting range: –15 to +15 dB
You can also change the gain in 0.1 dB units with the Up and Down buttons located on the right side.

(10) **Polarity reverse button [Polarity]**
Displays the polarity of the selected filter point.
Clicking this button permits the polarity to be reversed.

(11) **Table indication button**
Indicates the filter control in tabular form if this button is clicked. Clicking this button again reverts to the original display.

(12) **Scale change button**
If you click this button, a dialog for scale setting is displayed, enabling you to change the graph scale of the filter control.

(13) **Minimum amplitude adjustment buttons**
Increase or decrease the lower amplitude limit on a graduated scale.
Clicking the "Driver Alignment" tab causes the time correction setting screen between Xover boxes to be displayed.

(1) Minimum variation unit selection buttons [Increments]
Select the minimum units of the delay time that can be changed with the Up and Down buttons.

(2) Option button
If you click this button, a delay option dialog is displayed and you can select the unit of distance displayed on the delay distance indication button from meters, inches, and feet.
You can also set the temperature on the basis of which the delay distance displayed is calculated.

(3) Delay time indication button [Time (ms)]
Displays the delay time in each channel by means of numerical values. If you click this button, a dialog for delay time setting is displayed, enabling you to set the delay time by directly entering a numerical value.

(4) Delay distance indication button [Distance (meters/inches/feet)]
Displays the delay distance in each channel by means of numerical values. If you click this button, a dialog for delay distance setting is displayed, enabling you to set the delay distance by directly entering a numerical value.

(5) Up/Down button
Changes the delay time in minimum variation units.

(6) Delay ON/OFF button [On/Off]
Displays the ON or OFF status of the Delay function.
Click this button to turn on and off the delay function.
7.3.11. Output filter view (Filter function settings)

Clicking the filter box in the Output Flow view causes the Output filter view to be displayed in the Contents view.

In the Filter box, the number of filters that can be used and an overview of set filter characteristics are displayed.

[Filter box]

Number of usable filters
Overview of set filter characteristics

[Output filter view]

(1) Minimum frequency adjustment buttons
Increase or decrease the lower frequency limit on a graduated scale.
(2) Filter point symbol
Select the filter point from the filter point symbol as required. If you right-click a point on the filter point symbol, the popup menu shown at right is displayed. Clicking any option other than "Through" causes a circle to appear on the filter control area. To cancel it, right-click the filter point symbol again and select "Through." The circle on the filter control area disappears. A yellow circle indicates the selected filter point.

: Parametric equalizer (PEQ)
: High-pass filter (HPF)
: Low-pass filter (LPF)
: High shelving filter (High Shelving)
: Low shelving filter (Low Shelving)
: All-pass filter (All Pass)
: Notch filter (Notch)
: Horn equalizer (Horn EQ)

You can change the frequency and the gain if you drag the filter point on the filter control. When a white circle is displayed on the left side of the filter point, by clicking and dragging the white circle up and down, the Q value of the selected filter point can be changed.

(3) Filter control area

(4) Maximum frequency adjustment buttons
Increase or decrease the upper frequency limit on a graduated scale.

(5) Maximum amplitude adjustment buttons
Increase or decrease the upper amplitude limit on a graduated scale.

(6) Filter type indication button
Displays the type of filter of the selected filter point.
You can select the filter types from the pull-down menu if you click this button. Selecting "Through" causes the circle to disappear from the filter control area.

(7) Frequency indication button [Freq. (Hz)]
Displays the frequency of the selected filter point.
If you click this button, a dialog for frequency setting is displayed, enabling you to set the frequency by directly entering numerical values. (Setting range: Differs depending on the selected filter. See p. 164.)
The setting can also be changed in 1/24 octave units (step width can be changed with the Option button) using the Up and Down buttons located on the right side.

(8) Gain indication button [Gain (dB)]
Displays the gain of the selected filter point.
If you click this button, a dialog for gain setting is displayed, enabling you to set the gain by directly entering a numerical value. (Setting range: Differs depending on the selected filter. See p. 164.)
You can also change the gain in 0.1 dB units with the Option button or in 0.5 dB units using the Up and Down buttons located on the right side.

(9) Q indication button [Q]
Displays the Q value of the selected filter point.
Clicking this button permits the setting value to be selected from the pull-down menu.

(10) Filter ON/OFF button [On/Off]
Displays the ON/OFF setting status of each selected filter.
The ON/OFF setting can be changed by clicking this button.
(11) **Table display button**
If this button is clicked, the filter control is displayed in tabular form. Clicking this button again reverts to the original graphic display.

(12) **Option button**
Clicking this button causes the following pull-down menu to appear.

![Option Menu]

Scale...: Scale can be changed.
Q-Display: The method to display Q value can be changed. (Only available when the parametric equalizer, notch filter or all-pass filter is selected.)
Fine Resolution: You can change the frequency step width if "Frequency" is selected, and the gain step width if "Gain" is selected.

(13) **Minimum amplitude adjustment buttons**
Increase or decrease the lower amplitude limit on a graduated scale.
### 7.3.12. Mute view

Clicking the Mute box in the output flow view displays the Mute view in the Contents view (located beneath the Output flow view).

The Mute box cannot be stereo-linked.

The Mute view shows the "All Mute" state when this function is on.

[Mute box]

The Mute box turns into different icons as shown below depending on the Mute function ON/OFF and All Mute function ON/OFF.

<table>
<thead>
<tr>
<th>Mute function for each individual output</th>
<th>All Mute function is ON.</th>
<th>All Mute function is OFF.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute function for each individual output is ON.</td>
<td>![All icon]</td>
<td>![Mute icon]</td>
</tr>
<tr>
<td>Mute function for each individual output is OFF.</td>
<td>![All icon]</td>
<td>![Mute icon]</td>
</tr>
</tbody>
</table>

Only in this case, no output is muted.

[Mute view]

(1) **Mute ON/OFF button**

Displays the Mute ON or OFF state on it.

Double-clicking the button switches the Mute state for each output between ON and OFF.
7.4. D-981, D-983, and D-984VC Control Modules Settings

7.4.1. General description of the D-981, D-983, and D-984VC

Notes
- The controllable channels from the contact input/output or VCA are limited to the unit's channel where the control module is inserted.
- The D-2012C's function key can operate LED control for the multiple D-2008SP units, but the contact input operation takes precedence when the target D-2008SP has been LED controlled with the contact input.

[Contact Input function and contact output function]
Installing the optional D-981 or D-983 Remote Control Module or D-984VC VCA Control Module into the D-2008SP permits the D-2008SP's memory recall, volume Up/Down, channel ON/OFF, LED control and stereo input selection (when the D-936R or D-937SP is installed) to be remotely operated by external equipment. Also, the following statuses can be output to external equipment: D-2008SP's memory, channel ON/OFF, stereo input (when the D-936R or D-937SP is installed), LED control, and contact input.
For the installation of each module, refer to the instruction manual included with the D-2008SP.

External remote control is performed by shorting terminals 1 – 8 (1 – 24 for the D-983) to the C terminal. Taking the contact input setting as an example, when terminals 1 – 8 are assigned to preset memory Nos. 1 – 8 respectively by means of the memory selection function, if each terminal is shorted to the C terminal, preset memory Nos. 1 – 8 can be recalled.
Terminals 1 – 8 are assigned as "Preset memory 1 – 8" for both the initial input and output settings. Other contacts are assigned to "None" or "Normally break." By changing the settings on the contact input and output setting screens, many different functions can be assigned to the contact input and output.

The control target range with the contact input differs depending on the assigned function. The following table shows the control target range by the contact input.

<table>
<thead>
<tr>
<th>Function assignable to control input</th>
<th>Control target range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>Entire D-2000 system*</td>
</tr>
<tr>
<td>Volume UP/Down</td>
<td>D-2008SP with the built-in control module that accepts contact input.</td>
</tr>
<tr>
<td>Channel ON/OFF</td>
<td></td>
</tr>
<tr>
<td>Line Input</td>
<td></td>
</tr>
<tr>
<td>LED Control</td>
<td></td>
</tr>
</tbody>
</table>

The following table shows the contact output operations.

<table>
<thead>
<tr>
<th>Function assignable to control output</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>The function-assigned contact output operates as status output when the D-2008SP's function is performed.</td>
</tr>
<tr>
<td>Channel ON/OFF</td>
<td></td>
</tr>
<tr>
<td>Line Input</td>
<td></td>
</tr>
<tr>
<td>Channel ON/OFF</td>
<td></td>
</tr>
<tr>
<td>LED Control</td>
<td></td>
</tr>
<tr>
<td>Contact Input Status</td>
<td></td>
</tr>
<tr>
<td>Console Switch</td>
<td>The function-assigned contact output can be controlled by all D-2012C units within the system*.</td>
</tr>
</tbody>
</table>

* The D-2008SP with ID1 must be included in the system.

[VCA Operation]
Connecting the D-911 VCA Fader Unit to the D-984VC VCA Control Module (optional) installed in the D-2008SP allows the VCA box volume of any D-2008SP's channel to be adjusted with faders or volume controls. By default, no function is assigned to the VCA terminal.
The following table shows the control target range by the VCA.

<table>
<thead>
<tr>
<th>Function</th>
<th>Control target range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>D-2008SP to which the VCA control module is connected.</td>
</tr>
</tbody>
</table>
7.4.2. Contact input setting screen

Select "Option → Contact Input Setting..." from the menu. The Contact Input Settings screen is displayed. If two or more control modules are used, they can be switched using the Display Selection tab.

![Contact Input Setting Screen]

(1) **Function**
- Sets the terminal function.
  - Memory
  - Volume Up/Down
  - Channel On/Off
  - Line Input
  - LED Control
  - None

(2) **Parameter**
- Set the preset memory number when a function is set for "Memory," and the line select number of the module input when set for "Line Input."

(3) **Control**
- The control method to be assigned to a terminal when a function is set for "Channel On/Off" or "LED Control" is selectable from "Make" and "Pulse."
  - Make
    - When the "Channel ON/OFF" function is set, the channel is enabled if the corresponding terminal and C terminal are shorted, and comes on if opened.
    - Pulse
      - When the "Channel ON/OFF" function is set, the channel alternates between enable and disable whenever the corresponding terminal and C terminal are shorted. When the "LED Control" function is set, the D-2008SP's front panel-mounted level indicator alternates between ON and OFF whenever the corresponding terminal and C terminal are shorted.

(4) **Position**
- When the "Volume Up/Down" or "Channel On/Off" function is set, select the channel position from "Audio In," "CobraNet In," "Audio Bus," "Ext. In," "CobraNet Bus," "Audio Out" or "CobraNet Out." When the "Line Input" function is set, select the slot in which the D-936R or D-937SP module has been installed.

(5) **Channel/Contact**
- When the "Volume Up/Down" or "Channel On/Off" function is set, select the channel number for volume adjustment or Channel ON/OFF.
Contact input function assignment: Memory

Assign any desired preset memory Nos. 1 – 32 to the terminals.

**Step 1.** Click each terminal's Function button to select "Memory" from the pull-down menu.

**Step 2.** Click the Parameter button to select the preset memory number from the pull-down menu.

---

Contact input function assignment: Volume Up or Down

Assign the Volume Up or Down function to the terminal.

**Step 1.** Click each terminal's Function button to select "Volume Up/Down" from the pull-down menu. The selected terminal's function is set to "Volume Up" and the terminal with the next number is set to "Volume Down."

**Note**
The last number terminal cannot be set for “Volume Up.”

**Step 2.** Click the Position button to select the channel position from the pull-down menu. The positions of the two terminals are simultaneously set to the selected contents.
Step 3. Click the Channel/Contact button to select the channel number for volume adjustment from the pull-down menu. The channel numbers of the two terminals are simultaneously set to the selected contents.

Note
Switching off the power without saving fader values remotely changed by way of the D-981, D-983 or D-984VC modules returns the fader values to those stored in the preset memory.
**Contact input function assignment: Channel On/Off**

Assign the channel ON/OFF function to the terminal.

**Step 1.** Click each channel's Function button to select "Channel On/Off" from the pull-down menu.

**Step 2.** Click the Parameter button to select the control method of "Make" or "Pulse" from the pull-down menu.

**Step 3.** Click the Position button to select the channel position from the pull-down menu.

**Step 4.** Click the Channel/Contact button to select the channel number from the pull-down menu.

**Note**
When the control method is set to "Pulse," switching off the power without saving the Channel ON/OFF status remotely changed by way of the D-981, D-983 or D-984VC modules returns the Channel ON/OFF status to that stored in the preset memory.
**Contact input function assignment: Line Input**

Assign the line input function to the terminal.

**Step 1.** Click each terminal's Function button to select "Line Input" from the pull-down menu.

**Step 2.** Click the Parameter button to select the line select number from the pull-down menu.

**Step 3.** Click the Position button to select the slot in which the corresponding D-936R or D-937SP is mounted from the pull-down menu.

![Contact Input Setting](image)

<table>
<thead>
<tr>
<th>No.</th>
<th>Function</th>
<th>Parameter</th>
<th>Control</th>
<th>Position</th>
<th>Channel/Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Memory</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Volume Up</td>
<td></td>
<td></td>
<td>Audio In</td>
<td>4</td>
</tr>
<tr>
<td>4</td>
<td>Volume Down</td>
<td></td>
<td></td>
<td>Audio In</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>Channel On/Off</td>
<td>Make</td>
<td>ColorNet Bus</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Line Input</td>
<td>In 3</td>
<td>Pulse</td>
<td>Slot 2</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>LED Control</td>
<td>In 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>None</td>
<td>In 2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(Note: The image shows a portion of the screen with the Contact Input Setting window open, highlighting the steps mentioned above.)
Contact input function assignment: LED control

Assigning the D-2008SP’s front panel-mounted level indicator OFF function to the terminal.

D-2008SP

Step 1. Click each terminal’s Function button to select "LED Control" from the pull-down menu.

Step 2. Click the Control button to select the control method of "Make" or "Pulse" from the pull-down menu.
7.4.3. Contact output setting screen

Select "Option → Contact Output Setting..." from the menu. The Contact Output setting screen is then displayed.

If two or more control modules are used, they can be switched using the Display Selection tab.

Display Selection tab

### Function
- **Break**
  - Always at break.
- **Make**
  - Always at make.
- **Memory**
  - Outputs memory selection status.
- **Channel On/Off**
  - Outputs channel ON/OFF status.
- **Line Input**
  - Outputs line input selection status (the D-936R or D-937SP must be mounted).
- **LED Control**
  - Outputs LED control status.
- **Through Out**
  - Outputs input contact terminal status.
- **Console Switch**
  - Outputs the D-2012C Remote Console Unit's function key status

### Parameter
When the function is set for "Memory," select the preset memory number.
When the function is set for "Through Out," select the input terminal number.
When the function is set for "Line Input," select the line select number.

### Control
When the function is set for "LED Control," select the contact output from "Make" or "Pulse."
- **Make**
  - If the D-2008SP’s front panel-mounted level indicator goes out, the connection between the corresponding terminal and the C terminal is open.
- **Pulse**
  - A short circuit pulse is generated between the corresponding terminal and the C terminal whenever the D-2008SP’s front panel-mounted level indicator switches between ON and OFF.

Select the contact output when the "Console Switch" function is set.
- **Momentary**
  - If the D-2012C's function key is clicked, the corresponding terminal shorts to the C terminal.
- **Latch**
  - A short circuit pulse is generated between the corresponding terminal and the C terminal whenever the D-2012C's function key setting is switched between ON and OFF.
(4) Position
When the "Line Input" function is set, select the slot in which the D-936R or D-937SP module has been installed.
When the "Console Switch" function is set, select the ID number for the D-2012C to be controlled.

(5) Channel/Contact
When the "Channel On/Off" function is set, select the channel.
When the "Console Switch" function is set, select the function key number for the D-2012C to be set.

Contact output function assignment: Memory

Assign any desired preset memory number (1 – 32) recall interlocking output (tally) to the terminal.

**Step 1.** Click each terminal's Function button to select "Memory" from the pull-down menu.

**Step 2.** Click the Parameter button to select the preset memory number from the pull-down menu.
**Contact output function assignment: Channel On/Off**

Assign the channel ON/OFF interlocking output (tally) to the terminal.

**Step 1.** Click each terminal's Function button to select "Channel On/Off" from the pull-down menu.

**Step 2.** Click the Position button to select the channel position from the pull-down menu.

**Step 3.** Click the Channel/Contact button to select the channel number from the pull-down menu.

---

**Contact output function assignment: Line Input**

Assign the line input selection interlocking output (tally) to the terminal.

**Step 1.** Click each terminal's Function button to select "Line Input" from the pull-down menu.

**Step 2.** Click the Parameter button to select the input used for status output operations.

**Step 3.** Click the Position button to select the slot in which the corresponding D-936R or D-937SP is mounted from the pull-down menu.
Contact output function assignment: LED Control

Assign an interlocking output (tally) to a terminal for controlling the D-2008SP's front panel-mounted level indicator. A contact output closes ("makes") or opens ("breaks") in synchronization with the level indicator's operation to light or goes out. "Make" and "Pulse" methods can be used for contact output operation, as shown below:

Step 1. Click each terminal's Function button to select "LED Control" from the pull-down menu.

Step 2. Click the Control button to select the control method of "Make" or "Pulse" from the pull-down menu.
Assign the contact input status interlocking output (tally) to the terminal.

**Step 1.** Click each terminal's Function button to select "Through Out" from the pull-down menu.

**Step 2.** Click the Parameter button to select the contact input terminal used for status output operations from the pull-down menu.

**Note**
The contact inputs assignable by the D-981 and D-984VC are 1 – 8.
The contact inputs assignable by the D-983 are 1 – 24.
Assigning a Console Switch Function to a Terminal.
A contact output closes ("makes") or opens ("breaks") in synchronization with the D-2012C’s function key ON/OFF operations set here. The Momentary and Latch methods can be used for contact output operation.

**Step 1.** Click each terminal's Function button to select "Console Switch" from the pull-down menu.

**Step 2.** Click the Control button to select the control method of "Momentary" or "Latch" from the pull-down menu.

**Step 3.** Click the Position button to select the D-2012C's ID number from the pull-down menu.

**Step 4.** Click the Channel/Contact button to select the D-2012C's function key number from the pull-down menu.
7.4.4. VCA module setting screen (Only when the D-984VC is used)

Select "Option → VCA Module Setting..." from the menu. The VCA Module Setting screen is then displayed. If two or more VCA control modules are used, they can be switched using the Display Selection tab.

![VCA Module Setting Screen](image)

(1) **Position**
Select the channel position for VCA volume adjustment.

(2) **Channel/Contact**
Select the channel number for VCA volume adjustment.
VCA Channel Assignment

Set the channel to be controlled for the D-984VC module's input and output channel VCA terminals.

**Step 1.** Click each terminal's Position button to select the channel position from the pull-down menu.
Step 2. Click the Channel/Contact button to select the channel number from the pull-down menu.

Notes
• VCA volume cannot be adjusted from a PC.
• A single channel cannot be assigned to two or more VCA faders.
• If the faders for the channels to control are grouped, set the channel of the lowest number within the group. Otherwise, selecting other channels disables the VCA fader operation. (For the grouping method, refer to p. 67.)
7.5. CobraNet Module Settings

One of two types of bundle settings to connect the CobraNet equipment to the D-2008SP must be selected: Unicast and Multicast.

The input and output bundle to be used for the D-2008SP is set to 48 kHz for sampling frequency and 8 for the number of channels per bundle.

When connecting the D-2008SP to other CobraNet equipment, be sure to match the latency and bit length of both units.

Note
In the case of the multicast bundle, use 4 bundles or less as it wastes network resources.

7.5.1. Unicast bundle example

In the following connection, the D-2008SP's CobraNet output bundle number must match the CobraNet device's CobraNet input bundle number.
7.5.2. Multicast bundle example

In the following connection, the D-2008SP's CobraNet output bundle number must match the CobraNet input bundle numbers of both CobraNet devices (A) and (B).

![Diagram of CobraNet connection]

7.5.3. CobraNet bundle settings

Perform this setting for the selected unit.

**Step 1.** Select "Option → CobraNet Module Setting → CobraNet Bundle Setting" from the menu. The CobraNet Bundle Setting screen is then displayed.

![CobraNet Bundle Setting screen]

**Step 2.** Enter the bundle number.
Bundle numbers for two channels (A and B) can be set for both input and output.
Eight-channel audio data is contained in each bundle.
Step 3. Press the Advanced setting button to proceed advanced settings as needed.

![Advanced setting button](Advanced_setting_button.png)

**Notes**
The following items cannot be set online.

- **Latency and Bit Length**
  Select this combination setting.
  This setting is effective for all the D-2008SP units in the current working file simultaneously.

- **Conductor Priority**
  Enter the value according to the priority level.
  Normally, leave this setting as it is.

Step 4. Click the "OK" button.
7.5.4. CobraNet bundle matrix setting

Settings can be collectively changed in the case of the system where multiple D-2008SP units are linked together using Cobranet connection.

**Step 1.** Select "Option → CobraNet Module Setting → CobraNet Bundle Matrix Setting" from the menu. The CobraNet Bundle Matrix Setting screen is then displayed.

![CobraNet Bundle Matrix Setting](image)

**Step 2.** Set the bundle number.
The combination of output and input bundle numbers can be collectively set.

1. Double-click the crosspoint between the input and output to be combined.
The Bundle Setting screen is displayed.

![Bundle Setting](image)

2. Enter the bundle number.
Select the number from 1 through 255 for the multicast bundle, and from 256 through 65279 for the unicast bundle.
Channels A and B for each input and output can be set.
Each bundle includes 8 channels of audio data.
7.6.1. Word clock synchronization

One of the following three word clock synchronization methods can be selected for the D-2008SP.

Note
This setting cannot be performed online.

(1) Internal (initial value)
This is a standard word clock synchronization method. Use this setting when using neither an external clock generator nor the D-2008SP's CobraNet connection function. This setting cannot be selected when CobraNet is selected in the unit's input and output settings.

(2) CobraNet
This setting is automatically selected when the CobraNet use has been set on the unit’s I/O Setting screen.

Note
Performing the CobraNet setting on the unit’s I/O Setting screen automatically selects this setting even if the CobraNet interface module is not installed. In this case, no analog audio signal is output from other module, either.

(3) External
Use this setting when using an external clock generator.
This setting cannot be selected when CobraNet use has been set on the unit’s I/O Setting screen.

7.6.2. Settings

Note
When the CobraNet use has been set on the unit’s I/O Setting screen, the word clock synchronization method is fixed to "CobraNet," thereby disabling its selection and change.

Step 1. Select "Option → Wordclock Setting..." from the menu. The Wordclock Setting screen is then displayed.

Step 2. Select from the pull-down menu, then click the "OK" button.
7.7. External Control Port Settings

Either the serial port or TCP/IP port can be selected as external control port for the D-2008SP. The setting procedure is shown below.

**Note**
This setting cannot be performed online.

**Step 1.** Select "Option → External Control Port Setting..." from the menu. The External Control Port Setting screen is then displayed.

![External Control Port Setting](image)

**Step 2.** Set the port to be used.

2-1. When using the serial port
Select the serial port and set the communication speed (Baud rate).

Select one of the following 4 RS-232C's communication speeds (Baud rate).

- 115200 bps
- 38400 bps
- 19200 bps
- 9600 bps (default)

![External Control Port Setting](image)

2-2. When using the TCP/IP port
Select the TCP/IP port and enter a TCP port number from 3000 to 49151.

![External Control Port Setting](image)
Step 3. Set the Fine Gain Command.
Set whether the Fine Gain Command is used or not when the channel fader gain is controlled with external control command.
The Fine Gain Command permits the gain value to be set in 0.1 dB units.

Note
For details about external control protocol, refer to the separate Protocol Specification for External Control Communication, the latest edition of which can be obtained from our download site http://www.toa-products.com/international/.

Step 4. Click the "OK" button.

8. D-2012C FUNCTION SETTINGS

Selecting the D-2012C Remote Console Unit to be set in the Unit view causes the Console view to be displayed in the Main view.
8.1. Console View

In the Console view, the Console Setting view (offline mode) or Console Monitor view (online mode) is displayed depending on communication conditions.

8.1.1. Console setting view (function key, motorized fader and rotary encoder settings)

Assign the function or channel to be operated to the D-2012C’s function keys, motorized faders and rotary encoders.

(1) Function key setting button
(2) Function key name display
(3) Fader layer selection tab
(4) Level meter position display
(5) Fader SEL/MONI button
(6) Fader name display
(7) Encoder SEL/MONI button
(8) Encoder name display
[Function key settings]

Perform settings for the D-2012C's 8 function keys. Clicking the Function Key Setting button located on the left side of the function keys causes the function key setting screen to be displayed.

(1) **Name**
Set the name to be displayed above each function key in the Console view.

(2) **Function**
Sets the function to be assigned to the function keys. The control target range by the function key depends on the function assigned to the key. For the control target range, refer to the table on the next page.

**Note**
Each function of Memory Store, LED Control, Key Lock, and Monitor Clear can be assigned to only one of 8 function keys.
- **Memory**
  Recalls the setting status stored in preset memory. The D-2012C's current setting status can be stored in preset memory by clicking the function key in combination with the function key assigned to the memory storage function.
- **Memory Store**
  Click the key in combination with the function key assigned to the memory function.
- **Line Input** (D-936R or D-937SP must be installed)
  Switches the line (stereo) input of the D-936R Stereo Input Module or D-937SP Digital Input Module.
- **LED Control**
  Turns off the D-2008SP's front panel-mounted level indicator.
- **Fader Layer**
  Recalls the channel assignment status stored in the fader layer.
- **Console Switch**
  Sets the contact output of the D-981 or D-983 Remote Control Module or the D-984VC VCA Control Module installed in the D-2008SP to ON.
- **Key Lock**
  Enables and disables manual operation of the D-2012C's motorized faders, function keys, rotary encoders, etc.
- **Monitor Clear**
  Clears the selection of channels to be monitored.
- **External Control Switch**
  Allows the D-2008SP with ID 1 to transmit the function key ON/OFF data to an AMX or other external control devices using external control protocol. The external control device can transmit the external control command to the D-2008SP with ID 1, controlling its function key's indicator ON or OFF.
- **None**
  No function is assigned to the function key.

(3) **Parameter**
Set the preset memory number when a function is set to "Memory," the module input line select number when set to "Line Input" and the fader layer number when set to "Fader Layer."

(4) **Position**
Selects the slot in which the D-936R or D-937SP is inserted when a function is set to "Line Input."
## [Control target range by the function key]

<table>
<thead>
<tr>
<th>Function</th>
<th>Control target range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>Entire D-2000 system*</td>
</tr>
<tr>
<td>Memory Store</td>
<td></td>
</tr>
<tr>
<td>Line Input</td>
<td>All D-2008SP units within the system</td>
</tr>
<tr>
<td>LED Control</td>
<td>All D-2008SP units within the system*</td>
</tr>
<tr>
<td>Fader Layer</td>
<td>Operating D-2012C*</td>
</tr>
<tr>
<td>Console Switch</td>
<td>All D-2008SP units within the system*</td>
</tr>
<tr>
<td>Key Lock</td>
<td>Operating D-2012C*</td>
</tr>
<tr>
<td>Monitor Clear</td>
<td>All D-2008SP units within the system*</td>
</tr>
<tr>
<td>External Control Switch</td>
<td>D-2008SP* with ID 1</td>
</tr>
</tbody>
</table>

* The D-2008SP with ID 1 must be included in the system.
**Function key function assignment: Memory**

Assign any desired preset memory Nos. 1 – 32 to the function keys.

**Step 1.** Click each function key's Function button to select "Memory" from the pull-down menu.

**Step 2.** Click the Parameter button to select the preset memory number from the pull-down menu.

---

**Function key function assignment: Memory Store**

Assign preset memory storage function to the function keys.

Click each function key's Function button to select "Memory Store" from the pull-down menu.
Function key function assignment: Line Input

Assign the line input function to the function key.

**Step 1.** Click each function key's Function button to select "Line Input" from the pull-down menu.

**Step 2.** Click the Parameter button to select the line select number from the pull-down menu.

**Step 3.** Click the Position button to select the unit and slot in which the corresponding D-936R or D-937SP is mounted from the pull-down menu.
Function key function assignment: LED control

Assign the ON/OFF function of the D-2008SP’s front-mounted level indicator to the function key. The LED control works on all D-2008SP units. When the D-2008SP has been LED-controlled by an individual control input, the control input has precedence over the function key operation.

Click each function key's Function button to select "LED Control" from the pull-down menu.
Function key function assignment: Fader Layer

Assign any desired fader layer Nos. 1 – 4 to the function keys.

**Step 1.** Click each function key's Function button to select "Fader Layer" from the pull-down menu.

**Step 2.** Click the Parameter button to select the fader layer number from the pull-down menu.
Function key function assignment: Console Switch

Assign the console switch function to the function key.

Click each function key's Function button to select "Console Switch" from the pull-down menu.

Note
Assign the contact output to the console switch on the Contact Output Settings screen (see p. 96).
Function key function assignment: Key Lock

Assign the key lock function to the function key.

Click each function key's Function button to select "Key Lock" from the pull-down menu.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Function</th>
<th>Parameter</th>
<th>Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>None</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Memory1</td>
<td>Memory</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Memory Store</td>
<td>Memory Store</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Line Input</td>
<td>Line Input</td>
<td>In 3</td>
<td>LDL - Slot 2</td>
</tr>
<tr>
<td>5</td>
<td>LED Control</td>
<td>LED Control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Fader Layer</td>
<td>Fader Layer</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Console Switch</td>
<td>Console Switch</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Key Lock</td>
<td>Key Lock</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Categories:
- None
- Memory
- Memory Store
- Line Input (2)
- LED Control
- Fader Layer
- Console Switch
- Key Lock
- Monitor Clear
- External Control Switch
**Function key function assignment: Monitor Clear**

Assign the monitor channel selection clear function to the function key.

Click each function key's Function button to select "Monitor Clear" from the pull-down menu.

**Function key function assignment: External Control Switch**

Assign the external control switch function to the function key.

Click each function key's Function button to select "External Control Switch" from the pull-down menu.
[Motorized Fader and Rotary Encoder Channel Settings]

The D-2012C Remote Console features four fader layers capable of storing combinations of channel assignments for 12 motorized faders and 8 rotary encoders. Stored fader layers can be recalled anytime using the function key to which the “Fader Layer” function has been assigned, independent of preset memory.

Assign any desired channel to the motorized fader and rotary encoder. Two methods are available for the setting: one to set in the Console setting view and the other to set from the menu. (These methods are possible only when offline.)

**Method 1**

The following procedure is a method to assign channels to individual motorized faders and rotary encoders in the Console setting view.

**Step 1.** Select the layer to be set from 4 Fader Layer Selection tabs in the Console setting view.
Step 2. Click the SEL/MONI button for the motorized fader or rotary encoder to be set. The Console Channel Setting screen is displayed.

![Console Channel Setting](image)

**Step 3.** Select the unit ID.

**Step 4.** Select the channel area.

**Step 5.** Select the channel number.  
**Note**  
The same channel cannot be assigned to multiple motorized faders and rotary encoders in a single fader layer.

**Step 6.** Select the level meter position.  
Selecting the channel area and level meter position determines the level area (see p. 33).

(Example) Level area: Audio In (PFL)

![Level area](image)

**Step 7.** Select the fader knob color. (Layer 1 only)  
The fader color is common to the four fader layers.

**Step 8.** Click the OK button.

**Step 9.** Repeat these steps only for all motorized faders and encoders, and perform similar settings for other layers as well.
The following procedure is a method to make settings from the menu. The channel setting can be made to up to 4 fader layers each of up to 4 D-2012C units.

**Step 1.** Select "Option → Console Setting" from the menu.
The Console Setting screen is then displayed.

**Step 2.** Select the console ID from the Console ID tab, and fader layer from the Fader Layer tab.
Step 3. Make the fader/encoder related settings: unit ID, channel area, channel number, level meter position, and fader knob color.
Press the button to set, then select the necessary item from the pop-up menu.

Motorized fader/rotary encoder number

Unit ID

Channel area

Channel number

Level meter position

Fader knob color

Note
A set of the unit ID, channel area, and channel number to be assigned to the faders and rotary encoders cannot be duplicated in a single fader layer.
If duplicated, the corresponding channel box is displayed in a red frame.

Step 4. Perform settings for all faders and encoders.

Tips
• The fader/encoder setting data can be copied to the clipboard by holding down the Ctrl key and pressing C key after selecting these boxes. The copied data can be pasted by holding down the Ctrl key and pressing V key after selecting the target fader/encoder boxes.
• Multiple fader/encoder data boxes can be copied and pasted.
• Copy and paste is possible between units, and between fader layers.

Step 5. Click the "OK" button.
Setting is complete.

Note
If something is wrong with setting, the "OK" button cannot be clicked.
8.1.2. Console monitor view

The status of the corresponding D-2012C Remote Console can be monitored when in online mode. The function keys, motorized faders and rotary encoders on the D-2012C can be remotely operated in synchronization with their operation on the screen.

**Note**
Memory cannot be stored using the function key in the Console Monitor view.

If Key lock is set, the console monitor view is displayed as shown at right and any key except the key lock function-assigned key cannot be operated.
8.2. Fader Layers

It is possible to recall any one of four fader layers to which motorized fader and rotary encoder channels have been assigned, and to set which layer will be recalled when the power is switched on.

8.2.1. Recalling fader layers

Select "Option → Fader Layer Change → Layer (1 – 4)" from the menu or click the function key in the Console Monitor view.

Note
Layers that have not been assigned to the D-2012C's function key cannot be recalled. (Refer to p. 113.)

8.2.2. Fader layer settings at power on

Select "Option → Power On Fader Layer → Last Layer/Layer (1 – 4)" from the menu. Selecting Last Layer activates the layer last recalled by a layer number before the power was switched off.

Notes
• Layers that have not been assigned to the D-2012C's function key are not recalled. (Refer to p. 113.)
• After this setting has been performed, if the fader layer recall function assigned to a function key is so changed that it does not belong to any function key, this Power On Fader Layer setting remains as it is but its function does not operate.
• This setting is valid only when the memory setting's "Change Fader Layer" item is set to "None." (Refer to p. 148.)

Tip
When the system includes 2 or more D-2012C units, the fader layer to be recalled at power on can be set for each individual unit.
9. SYSTEM FUNCTION SETTINGS

9.1. User Level and Restriction Settings

9.1.1. What is the user level

Two types of user levels are available for the D-2000 Setting Software as follows.
- Administrator: When no user level is set, its level is automatically set to "Administrator." When you log on as an administrator on the logon dialog, the user level is also "Administrator."
- Operator: When you do not log on as an administrator on the logon dialog, the user level is "Operator."

9.1.2. Enabling the user level

**Step 1.** Select "Option → Security Settings" from the menu.
The security setting dialog is displayed.

**Step 2.** Tick the "Enable User Level" checkbox.
The administrator password setting dialog is displayed.

**Step 3.** Enter the password in the Password and Confirm Password fields.
**Note**
Password is case sensitive and 4 to 16 characters long.

**Important**
If you forget the password, you cannot log on as an administrator and are subject to restrictions on setting changes.
Pay special attention to your password management.
9.1.3. Logging on when the user level is enabled

Enabling the user level displays the following logon screen when the setting file is opened next time.

When logging on as an administrator, enter a set password and click the "OK" button. If a different method than this is used to close the logon screen, the user level is logged on as an operator. The level logged on is displayed on the right side in the upper part of the main screen as "Administrator" or "Operator."

**Administrator:**

**Operator:**

9.1.4. Operations that can be restricted

The following operations can be restricted depending on the user level.

- Unit creation, deletion, and configuration change (Also, import operation from the file menu cannot be performed.)
- Unit name change and memory setting change
- Storage in memory (Prohibits storage against all Memories)
- Change safe function setting change
- Write protection to function boxes

**Note**

The above operations are restricted only on the D-2000 Setting Software. They can be performed from the D-2012C or by means of external control.

9.1.5. Performing restriction settings

**Step 1.** Select "Option → Security Settings" from the menu. The Security Settings dialog is displayed.
Step 2. Select the restriction level from the pull-down menu of each Restriction settings item. You can set 4 different levels of restrictions for each item.

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Both administrators and operators can change the item and Restriction settings.</td>
</tr>
<tr>
<td>Low</td>
<td>Administrators can change the item and Restriction settings. Operators cannot change the item, but can change Restriction settings.</td>
</tr>
<tr>
<td>Mid</td>
<td>Administrators can change the item and Restriction settings. Operators cannot change the item and Restriction settings.</td>
</tr>
<tr>
<td>High</td>
<td>Administrators cannot change the item, but can change Restriction settings. Operators cannot change the item and Restriction settings.</td>
</tr>
</tbody>
</table>

9.1.6. Restricting each box's parameter change

It is possible to set restriction of parameter change to individual boxes displayed in the flow view. After selecting the box on the flow view, select "Edit → Box Write Protect" from the menu. You can set 4 different levels of restrictions for each item in the same way as stated in the preceding clause. (Off, Low, Mid, or High) A keylock mark is indicated on the write-protected box.
9.2. Change Safe Function Setting

The Change Safe function is a function to prevent the following parameters from being recalled when the preset memory number is changed.

- **Fader:** Gain, channel ON/OFF, grouping number, group trim gain
- **Matrix crosspoint:** Gain, crosspoint ON/OFF

Assign the channel the fader belongs to and the matrix crosspoint to any one of 4 groups (a) to (d). Then, the parameters of channel fader and matrix crosspoint assigned to the Change Safe group cannot be recalled from the preset memory.

The Change Safe groups (a to d) are displayed in the Memory view, if set. (Refer to p. 31.)

**Notes**

- The Change Safe groups (see p. 128 and p. 129) assigned to channels and matrix crosspoints are common to all preset memories.
- As long as the Change Safe group is set to the currently selected preset memory (see the next page), the above-mentioned parameters of the channel (fader) and matrix crosspoints included in the group can neither be stored nor discarded even if they are changed.
- If you set a preset memory where such 2 channels are grouped in the same grouping number as one assigned to the Change Safe group and the other not, both channels' faders may indicate different values. (See below.)
- When changing the fader's grouping number by external control protocol, also note the relation with the Change Safe group setting to avoid the difference in fader values as explained above.

[Example when grouped faders indicate different values]

<table>
<thead>
<tr>
<th>Preset memory number</th>
<th>Change Safe group</th>
<th>Channel</th>
<th>Change Safe group</th>
<th>Grouping number</th>
<th>Fader</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>None</td>
<td>1</td>
<td>a</td>
<td>1</td>
<td>0 dB</td>
</tr>
<tr>
<td>2</td>
<td>a</td>
<td>2</td>
<td>None</td>
<td>1</td>
<td>0 dB</td>
</tr>
</tbody>
</table>

Recalls Preset memory 2.

- The fader value is maintained by the Change Safe function.
- The fader value and grouping number are switched to those saved in Preset memory 2.

Both faders belong to the same grouping number, but indicate different values.

Moving one of the faders makes both fader values equal owing to the grouping function.
9.2.1. Enabling the Change Safe function

**Step 1.** Select "Option → Change Safe Setting" from the menu.
The Change Safe Setting dialog is displayed.

![Change Safe Setting dialog](image1)

**Step 2.** Tick the "Enable the Change Safe function" checkbox.
The Power On Memory Setting dialog is displayed.

![Power On Memory Setting dialog](image2)

**Notes**
- When the Change Safe function is enabled, no Change Safe group can be set for the Power On Memory function.
- The Change Safe groups assigned to channels, preset memories, and matrix crosspoints are all cleared at the time when the Change Safe function is disabled.

**Step 3.** Select the Power On Memory number to be set from the pull-down menu.
**Note**
The Last Memory cannot be set.

![Power On Memory Setting dialog](image3)
9.2.2. Channel setting (only when the Change Safe function is enabled)

Click each channel button, then select one Change Safe group to which the channel belongs from the displayed pull-down menu.

![Channel Setting](image)

9.2.3. Memory setting (only when the Change Safe function is enabled)

Set the Change Safe group (a to d) for each preset memory by clicking the corresponding group buttons. Two or more groups per preset memory can be set.

**Tip**
The Change Safe groups assigned to the preset memories are also displayed in the Memory view (see p. 31).

![Memory Setting](image)

9.2.4. Change Safe group setting example

![Change Safe Setting](image)
9.3. Console SEL/MONI Link Setting

Pressing each Monitor channel selector key on the D-2012C causes the corresponding channel of the D-2008SP on the D-2000 Setting Software to be selected. When the SEL/MONI key interlock function is enabled according to the procedure below, the setting data is stored in the PC's internal memory, permitting the screen display on the PC's D-2000 Setting Software to be switched in synchronization with the D-2012C operations.

**Note**
This setting should be performed on each individual PC, and cannot be stored in the data file.

**Step 1.** Select "Option → Console SEL/MONI Link Setting" from the menu. The Console SEL/MONI Link Setting dialog is displayed.

**Step 2.** Tick the "Enable SEL/MONI Link" checkbox.

**Step 3.** Tick the console ID number checkboxes to link.

**Step 4.** Click the "OK" button.
10. PC CONNECTIONS

10.1. Connections between a PC and the Unit

Connect a PC, the D-2008SP, and the D-2012C to a switching hub using LAN straight cables individually.

![Diagram showing connections between PC, D-2008SP, and D-2012C]

10.2. Method to Enable Communications between the PC and the Unit

**Step 1.** Perform network settings by selecting "Communication → Comm Setting..." from the menu. (See the next page "Connection Settings.")

**Step 2.** Make communications in any of the following methods. (See p. 13.)

- **2-1.** Make communications by selecting "Communication → Connect..." from the menu. (See p. 142.)
- **2-2.** Make communications by selecting "Communication → Bulk Transmission..." from the menu. (See p. 143.)
- **2-3.** Make communications by selecting "Communication → Bulk Receiving..." from the menu. (See p. 143.)
10.3. Connection Settings

Perform settings needed to communicate with the units in this section. Settings such as network settings and unit ID settings can be made and the firmware version number can be confirmed.

**Step 1.** Select "Communication → Comm Setting..." from the menu. Network settings of the units found on the network are displayed. The table below shows the factory preset settings for each unit.

<table>
<thead>
<tr>
<th></th>
<th>D-2008SP</th>
<th>D-2012C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subnet mask</td>
<td>255.255.255.0</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>Default gateway</td>
<td>0.0.0.0</td>
<td>0.0.0.0</td>
</tr>
</tbody>
</table>

If a unit's IP address is duplicated or inappropriate network setting has been performed, such device is displayed in the "Unconnectable units" list. If a D-2008SP is selected in the list, its front-mounted LAN DETECT indicator lights up.

- To change the unit's IP address setting, advance to **Step 2**.
- When transmitting the settings data changed in **Step 2** to the unit, advance to **Step 3**.
- When changing the PC's network settings, change them from the Windows Control Panel. PC network setting cannot be changed using the D-2000 software.
- When connecting to the unit via a router, network settings are not displayed on this screen. The unit network settings cannot be changed. Connect such unit to a LAN and perform the network settings in advance.

If no unit was detected:

Install the undetected unit within the reach of broadcast packet. Communications may be interrupted when the PC is firewall-protected.
Step 2. Change the unit’s network setting.
Select the unit for which you want to change the network setting, then click the "Modify IP setting" button. The IP Setting screen is displayed.
Set the IP address, then click the "OK" button.

Step 3. Transmit changed setting data to the unit.
Clicking the "Send the setting" button transmits the IP settings to the corresponding unit and causes the unit to be automatically restarted. Restart is completed in approximately 40 – 50 seconds.

- If a unit needs to be connected via a router, advance to Step 4 to add it.
- If the unit that should not be communicated with is displayed in the list, advance to Step 5 to delete it from the list.
- Advance to Step 6 when all the units to be connected are displayed in "Connectable units" list.
- When the PC has two or more IP addresses, select the the unit and IP address to be communicated with from the PC's IP address.
Step 4. Add the unit to be connected via a router in a list. Clicking the "Add" button displays the "Add target unit" screen. Enter the IP address of the added unit and click the "OK" button.

![Add target unit screen](image)

**Note**
Network setting for the unit to be connected via a router cannot be changed using the method described in Step 2.
If you need to change the network setting, connect such unit to a LAN and change the network setting in advance.

Step 5. Delete the unit from the list.
Select the unit to be deleted, then click the "Delete" button.
The selected unit is deleted from the list.

Step 6. Click the "Next" button, then the Firmware version check screen is displayed.

![Firmware version check screen](image)

- When the firmware version of a D-2008SP is older than that the D-2000 software supports, the D-2008SP is displayed in the Unconnectable units list.
- If a unit that does not need to be controlled is displayed, advance to Step 7 to delete it from the list.
- When updating firmware, advance to Step 8 to execute data backup, then advance to Step 9 to update the firmware.
- If all units to be controlled are shown in the Controllable units list, advance to Step 10.

Step 7. Delete the unit from the list.
Select the unit to be deleted, then click the "Delete" button.
The selected unit is deleted from the list.
Step 8. Backup the Data.
Select the unit from the "Uncontrollable units" and click the "Backup Data" button. The "Save As" screen is displayed, and enter a filename to be saved and click the "OK" button. Data backup begins.

The following screen is displayed after backup completion.

Advance to Step 9 to update the firmware.
Step 9. Update Firmware.
Select a unit from the Uncontrollable units list and click the "Firmware update" button.

The following message is displayed.

If data backup is completed, click the "Firmware update" button. The firmware is updated.

After firmware update is completed, the unit is shown in the Controllable units list.

Note
This procedure does not update the D-2012C firmware of version 2.0.0.
In this case, use the dedicated "D-2012C Firmware Updater software" in the CD supplied with the D-2008SP (firmware version 3.0.0 or later). For details, refer to the separate installation manual.
Step 10. Click the "Next" button.
The Unit ID Setting screen is displayed. The "Next" button is displayed if the D-2012C is found on
the network, and the "Finish" button displayed if not found.

[If the D-2012C is found on the network:]
Step 11. Delete the unnecessary units with duplicate ID number from the list.
Select the units to be deleted from the list, then click the "Delete" button. The selected units are deleted.

Step 12. Change the D-2008SP's ID number when needed.
Select the unit in the "Uncontrollable units" list, then click the "Modify Unit ID" button.
The Unit ID Setting screen is displayed.

To set the D-2008SP's ID number, select the ID from the pull-down menu, and click the "OK" button.

Step 13. Transmit the setting data to the unit when changed.
Clicking the "Send the setting" button transmits the ID settings to the corresponding unit and causes the unit to be automatically restarted. Restart is completed in approximately 40 – 50 seconds.

Step 14. Click the "Finish" or "Next" button.

14-1. If the "Finish" button is clicked:
Setting is complete.
14-2. If the "Next" button is clicked:
The Console ID Setting screen is displayed.

• If the D-2012C's ID number has not been set, the unit is displayed in the Uncontrollable units list.
• If a unit that does not need to be controlled is displayed, advance to Step 15 to delete it from the list.
• To set the D-2012C's ID number, advance to Step 16.
• If all units to be controlled are shown in the Controllable units list, advance to Step 17.

Step 15. Delete the unit from the list.
Select the unit to be deleted, then click the "Delete" button.
The selected unit is deleted from the list.

Step 16. Set the D-2012C's ID number.
Select the unit from the Uncontrollable units list and click the "Modify Console ID" button.
The Console ID Setting screen is displayed.

To set the D-2012C's ID number, select the ID from the pull-down menu, and click the "OK" button.

Step 17. Click the "Finish" button.
Setting is complete.
10.4. Communications

Connect to the unit displayed "Connectable units" field in the Unit's IP setting screen.

![Unit's IP Setting screen]

**Step 1.** Select "Communication → Connect...," "Communication → Bulk Transmission...," or "Communication → Bulk Receiving..." from the menu.

- **Connect...**:
  - If the setting data of the PC differ from those of the destination units, transfer direction can be set for each item. (See p. 142.)

- **Bulk Transmission...**:
  - Transfers all setting data from a PC to each unit in bulk. (See p. 143.)

- **Bulk Receiving...**:
  - Transfers all setting data from each unit to a PC in bulk. (See p. 143.)

**Notes**

- If no unit has been set on the D-2000 Setting software, only "Bulk Receiving..." can be selected.
- All data related to the D-2012C are stored in the D-2008SP. (The D-2012C has no data.) So, even if the D-2012C is not detected on the network, the bulk reception of the setting data is possible.

While the screen below is displayed, the target unit designated with the connection settings are being detected.

![During connection confirmation]
If no units on the network have been set for the connection settings, the Unit's IP Setting screen is displayed. Perform network and Unit ID settings as needed.
If data and status for the module do not match:

If all data for the Module settings and the Module status do not match exactly, the Slot Information screen is displayed during connection.

- **Module Settings:**
  Model of module stored in memory
- **Module Status:**
  Model of module inserted in the unit

The unmatched data on module models are highlighted in red as shown above. Unless all data for the Module Settings and the Module Status match with each other, the unit does not operate correctly.

[Operating the unit according to the Module Settings]
Click the "No" button to disconnect communications, and reinstall modules into the unit correctly.

[Operating the unit according to the Module Status]
Click the "No" button to disconnect communications, and change the Module Settings.

**Tip**
Clicking the "Yes" button permits correct operation only for the unit's slot-mounted modules of which Module Settings and Module Status data match with each other.
1.1. When "Communication → Connect..." is selected from the menu;

To enable communications between the PC and the unit, both setting data must be the same. If an item of data is different from each other, transmission direction can be designated for each item. During connection, the Communication screen is displayed. If the setting data of PC differ from those of the destination unit, "Different" is indicated in the Status column.

Follow the procedures below to designate the data transfer direction, and transfer the setting data.

- **Transferring setting data for the selected unit in bulk**
  Select xxx (Unit name: "Unit 1" in the above example), and then the transfer direction.

- **Designating transfer direction for each data item**
  Select one "Different" data item, and then its transfer direction. Repeat this process for all "Different" data items. Different transfer direction can be selected for each data item.

After designating the data transfer direction, click the "Update" button to transfer the setting data.
1.2. When "Communication → Bulk Transmission..." is selected from the menu;
   All setting data can be transferred from the PC to the unit in bulk.
   The Communication screen is displayed, and data transfer begins.

1.3. When "Communication → Bulk Receiving..." is selected from the menu;
   All setting data can be transferred from the unit to the PC in bulk.
   The Communication screen is displayed, and data transfer begins.
If the unit has not been set on the D-2000 Setting software;

The Bulk Receive screen is displayed before the communication screen is displayed. Performs connection to the unit shown in the list.

• For the unit to be connected via a router, use this screen to add it if not added in the connection setting.

  (1) Click the "Add" button. 
  The Add target unit screen is displayed.

  (2) Enter the IP address for the unit to be added, then click the "OK" button. 
  The unit is added to the list on the Bulk Receive screen.

• If the unit unnecessary to be connected is displayed, delete it.

  Select the unit to be deleted, then click the "Delete" button.

The selected unit is deleted from the list on the Bulk Receive screen.
• When all the units to be connected are displayed, start the bulk receiving;

(1) Click the "Start" button.

The Communication screen is displayed, allowing the data transfer.
(2) Click the "Completed" button after data transfer completion.

Step 2. Select "Communication → Disconnect..." from the menu. This terminates communications between a PC and the unit.
11. PRESET MEMORY SETTINGS

D-2008SP’s set parameters can be stored as preset memory (see p. 151). There are 32 preset memories. You can freely recall them or write data into them.

11.1. Recalling the Preset Memory

Select "Memory → Change → Memory (1 – 32)" from the menu.

It is also possible to recall from the Memory View (see p. 31).

11.2. Writing Data into the Preset Memory

Select "Memory → Store → Memory (1 – 32)" from the menu.
11.3. Memory Setting

Select "Memory → Memory Setting" from the menu. The Memory Settings screen is then displayed.

11.3.1. Changing the memory name

Select "Memory Names..." from the menu. Memory Name Setting screen is displayed. Enter desired name (up to 20 alphanumeric characters).

**Note**
To make the unit name blank, enter a space with the space key.
Deleting the default name cannot set it blank. (The default name remains as it is.)

11.3.2. Preset memory crossfade time setting

Select "Memory → Crossfade Time" from the menu. The crossfade time setting dialog is displayed.
Set the crossfade time in seconds (10 s max. in 0.1 s units) when the currently selected preset memory is switched over to a newly recalled one.
Setting the crossfade time in the All Memory box causes all preset memories (Memory 1 through 32) to be set for the same value simultaneously. When all preset memories do not have the same setting, the indication "-- -- --" appears in the All Memory box.
Parameters to be cross-faded are Input/output channel gains, channel ON/OFF, bus assignment, and cross-point gains.
Parameters other than those above instantaneously switch when the preset memory is recalled.

**Note**
When the currently selected preset memory is switched over to a newly recalled one, the channels of which phantom power ON/OFF, PAD, line input mode, and line input selection have been changed are muted for a specified period of time.

11.3.3. Fader layer recall setting

The fader layer number to be recalled on the D-2012C by the preset memory recall can be set for each individual D-2012C. The target layer number and D-2012C ID number can be selected from the pull-down menu of "Change Fader Layer" item on the screen.
When "None" is selected, the currently recalled layer number is maintained.

**Note**
When "None" is selected for the fader layer recall assigned to the preset memory number of the Power On Memory (see the next page), the fader layer number set for the Power On Fader Layer (see p. 122) is recalled at power on.
The fader layers are not recalled unless they have been assigned to any D-2012C's function key. (See p. 108.)
11.4. Setting the Preset Memory Recalled When Power Is Turned On

Select "Memory → Power ON → Last Memory/Memory (1 – 32)" from the menu. When selecting "Last Memory," the unit activates with the settings stored in the last recalled preset memory number before the power was turned off.

**Note**
When the Change Safe function (see p. 126) is used, "Last Memory" or any preset memory to which the Change Safe group or groups have been assigned cannot be set for the Power On Memory function.
12. GLOSSARY

• Auto-Leveler function
The auto-leveler function performs to keep the output level constant by suppressing the change of sound volume. Setting the target level (the constant level to be automatically adjusted to) and the maximum gain (the amount of gain to bring the lower level to the target level) automatically compensates for the input level. Note that setting an excessive amount of gain increases the input sensitivity, easily causing feedback.

• Gate function
The gate function allows the input signal to be passed, attenuated or cut depending on its signal level. The gate allows the signal to pass when open, and attenuates or cuts the signal when closed. The gate opens when the input signal reaches a level above the Threshold plus Hysteresis parameter (half the Hysteresis). Once open, the input signal must reach a level below the Threshold minus Hysteresis parameter to close. The Ducker function and the NOM attenuation function are controlled by the gate's open/close operations.

  **Note**
The gate opens when the input channel is set to ON even if the gate is set to OFF.

• Auto-Mixing function
Both the Ducker function and the NOM Attenuation function are Auto-Mixing functions that automatically adjust individual input channel gains in response to input signal level. The Auto-Mixing functions can operate in each of the 4 groups, GROUP A through D. Although all the input channels are grouped into GROUP A by default, they can be individually assigned to the desired groups.

• Ducker function
The ducker function is one of the D-2008SP's Auto-Mixing functions that adjusts individual input channel gains in response to input signal level. When a received signal exceeds the gate threshold level, the ducker function automatically attenuates all other input signals which are lower than that input channel in priority.

  **Note**
When an input channel is set to OFF, the ducker function for that channel does not operate.

• NOM Attenuation function
The NOM Attenuation function is one of the D-2008SP's Auto-Mixing functions that adjusts individual input channel gains in response to input signal level. NOM is an acronym of Number of Open Microphones, and represents the number of microphones in open status (the number of input channels with open gates). The NOM attenuation function automatically adjusts the open microphone's input channel gain depending on the number of open microphones. The open microphone channel gain is attenuated by the gain set on the Auto mix View each time the number of open microphones doubles. The use of this function allows an output level to be kept constant, thus helping to prevent feedback. This function operates in individual Auto-Mixing groups.

  **Note**
When an input channel is set to OFF, the NOM attenuation function for that channel does not operate.
**Preset memory**

Set parameters can be stored in preset memory 1 – 32.

Parameters that can be stored in preset memory are as follows:

- **Input channel parameters:** PAD, phantom power, line input mode selection, line input selection, input trim gain, input trim polarity, input filter, Compressor / Auto-Leveler mode selection, Compressor / Auto-Leveler, level sensibility, gate, auto mixing function group, ducker, NOM attenuation function ON/OFF, input channel gain, channel ON/OFF, and group trim gain

- **Bus channel parameters:** Feedback suppression (dynamic mode ON/OFF, settings of the number of filters, and filter value set in auto mode and dynamic mode), sub-in-mix-gain, sub-in-mix ON/OFF, bus channel gain, channel ON/OFF, and group trim gain

- **Output channel parameters:** Output channel gain, group trim gain, channel ON/OFF, filter (including crossover), compressor, delay time, and mute

- **Others:** Stereo link setting, crossover function configuration setting, NOM attenuation function setting, and matrix assignment

**Change Safe function**

The Change Safe function works so as not to recall the following parameters when the preset memory is changed.

- **Fader:** Gain, channel ON/OFF, grouping number, group trim gain
- **Matrix crosspoint:** Gain, crosspoint ON/OFF

**Application example**

In hotel's banquet halls, when a large room is divided by partitions, different setting data for the newly used room can be recalled from the preset memory while not affecting the sound volume or input-to-output routing in the other room being used.
13. SETTING DATA SAMPLES

Setting data samples are contained in the CD supplied with the D-2008SP as files "Gymnasium.d8t," "Hall.d8t," and "Changesafe.d8t."

Providing the simple setting examples (data samples) intends to help you make the on-site system design using the D-2000 Setting Software.

Each data sample is created for the system on the assumption of imaginary facility.
Referring to the sample as an example, make the optimum settings for the actual system depending on the installation site or unit configuration.
Pay special attention to the Change Safe function setting as incorrect set contents or incorrect operations may result in such system malfunctions that no sound is output or the sound volume cannot be reduced.

The setting data samples have been set in the following environments.

<table>
<thead>
<tr>
<th>Software</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-2000 Setting Software</td>
<td>Ver. 4.0.0</td>
</tr>
<tr>
<td>D-2008SP firmware</td>
<td>Ver. 4.0.0</td>
</tr>
<tr>
<td>D-2012C firmware</td>
<td>Ver. 4.0.0</td>
</tr>
</tbody>
</table>

13.1. Setting Example for Use in Gymnasiums

The data sample "Gymnasium.d8t" is a setting example for the system in a gymnasium.

13.1.1. System description

- Includes one D-2008SP and one D-2012C.
- Assumed to be used in an elementary school gymnasium.
- Intended for speech and music playback applications such as lectures or gym classes.
- The sample data is so made to operate the system by simply turning on the power and increasing the input source fader.
- Memory 2 provides a pattern that speech has precedence over music playback, which is set by a ducker function in the Automix view. In this pattern, beginning speech automatically decreases BGM volume, and stopping speech restores the BGM volume to its original level.
- To increase sound clarity for the microphone and wireless microphone inputs, HPF is set in the input Filter view. To protect these inputs from excessive signals, the Comp function is set.
- To simplify the volume control for CD, MD, and cassette player inputs, the stereo link is set.
- A microphone bus is set up, and the FBS function is set for the bus to prevent feedback.
- Recommended parameters for the speakers to be connected to the speaker output are set in the output Filter view.
- To protect the speakers from excessive signals, the Comp function is set.
- Channel assignment is made to the D-2012C so that inputs and outputs can be individually controlled.
- Operating the faders of the BGM bus and microphone bus controls the sound volume collectively on each BGM channel and microphone channel.
- Fader layers are not used.
- A monitor speaker is connected to the monitor output, enabling sound monitoring without actually outputting sound.

13.1.2. System configuration

- D-2008SP (with three D-2000AD1s and two D-2000DA1s) x 1
- D-2012C x 1
- Main speaker: ES-0426 x 2
- Sub-speaker: F-2000B x 2
- Monitor speaker: F-1300B x 1
13.1.3. Equipment layout

![Equipment layout diagram]

- **Stage**
- **Main speaker**
- **Sub-speaker**
- **D-2008SP and D-2012C**

13.1.4. System diagram

![System diagram]

- **CD player**
- **Cassette player**
- **MD player**
- **Wireless tuner**
- **MD recorder**
- **Main speaker**
- **Sub-speaker**
- **Monitor speaker**
- **Switching hub**
- **D-2008SP**
- **D-2012C**
- **Sound source equipment**
- **Line input**
- **MONITOR BUS**
- **LAN**
13.2. Setting Example for Use in Multi-Purpose Halls

The data sample "Hall.d8t" is a setting example for the system in a multi-purpose hall.

13.2.1. System description

• Includes two D-2008SPs and two D-2012Cs.
• Assumed to be used in a facility with a dedicated operator, offering a certain degree of setting flexibility.
• Permits two separately-located D-2008SPs to transmit audio signals to each other using the Cobranet.
• The speaker output is divided into Low, Mid, and High in the Xover view, and the recommended speaker parameters are set.
• To increase sound clarity for the microphone and wireless microphone inputs, HPF is set in the Filter view.
• To protect the microphone and wireless microphone inputs from excessive signals, the Comp function is set in the Comp/Leveler view.
• The FBS function is set for the microphone and wireless microphone to prevent feedback.
• Channel assignment is made to two D-2012Cs so that inputs and outputs can be separately controlled: input channels are assigned to the D-2012C with ID 1, and output channels to the D-2012C with ID 2.

13.2.2. System configuration

• D-2008SP (with two D-2000AD1s, five D-2000DA1s, and one D-2000CB) x 1
• D-2008SP (with two D-2000AD1s, six D-2000DA1s, and one D-2000CB) x 1
• D-2012C x 2
• Main speakers (3 sets of the following 3 speakers)
  - SR-C8L x 2 (driven by bi-amplifier)
  - SR-C8S x 2 (driven by bi-amplifier)
  - SR-C15B x 1
• Sub-speaker: HX-5B x 10
• Monitor speaker: F-1300B x 2

13.2.3. Equipment layout

![Equipment layout diagram]

- Main speaker
- Sub-speaker
- D-2008SP (ID 1)
- D-2008SP (ID 2) and D-2012Cs (ID 1 and ID 2)
13.2.4. System diagram

- Microphone
  - Input 1 – 4
- Line
  - Input 5 – 8
- D-2008SP (ID 1)
  - Output 1 – 9
  - Output 10 – 18
- CobraNet
  - LAN
- Switching hub
  - LAN
- D-2012C (ID 1)
  - LAN
- D-2012C (ID 2)
- Wireless microphone
- Wireless tuner
  - Input 1 – 4
  - Input 5 – 6
- CD player
  - Input 7 – 8
- D-2008SP (ID 2)
  - Output 1 – 9
  - Output 10 – 19
  - Output 21 – 22
  - Monitor output (output 20)
- Main speaker (L)
- Main speaker (R)
- Main speaker (C)
- Sub-speaker
- Monitor speaker
- MD recorder
13.3. Setting Example for Use in Hotel's Banquet Halls (Change Safe function is used.)

The data sample "Changesafe.d8t" is a setting example for the system in a hotel's banquet hall.

13.3.1. System description

- Assumed to be used in a hotel's banquet hall divisible into 3 smaller rooms.
- Includes one D-2008SP to be located in the main room, and one D-2012C in each divided room (3 units in total).
- Intended for speech and music playback applications.
- Allows operations for a combined room created by removing the partition between 2 rooms.
- Preset memories are set suitably for each divided room applications.
- Applications in other 2 rooms may change while one room is in use. (See p. 158, "Example of use.")

13.3.2. System configuration

- D-2008SP (with five D-2000AD1s and three D-2000DA1s) x 1
- D-2012C x 3

13.3.3. Equipment layout
13.3.4. System diagram

A: Microphone
A: Wireless microphone
A: CD player
A: Wireless tuner
A: MD player
A: Main speaker

B: Microphone
B: Wireless microphone
B: CD player

C: Microphone
C: Wireless microphone
C: CD player
C: MD player
C: MD recorder
C: Main speaker
C: Sub-speaker

D-2008 SP

Switching hub

D-2012C (ID 1)
D-2012C (ID 2)
D-2012C (ID 3)

MONITOR BUS
LAN

Output 1 – 2
Output 3
Output 4
Output 5 – 6
Output 7 – 8
Output 9 – 10
Output 11 – 12

Input 1 – 2
Input 3 – 4
Input 5 – 6
Input 7 – 8
Input 9 – 10
Input 11 – 12
Input 13 – 14
Input 15 – 16
Input 17 – 18
Input 19 – 20
Input 21 – 22

Note
Alphabets A, B, and C represent the equipment to be used in the banquet hall A, B, and C, respectively.
13.3.5. Description for settings

[Example of use]

Below is an example where one of divided 3 rooms remains in use with 3-divided room setting pattern, and its setting pattern is switched to 2-divided room setting pattern after the remaining 2 rooms are combined into one.

• Memory 1 (3-divided room setting pattern for each divided room A, B, and C)

<table>
<thead>
<tr>
<th>Change Safe group setting: None</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banquet hall A</td>
</tr>
<tr>
<td>Banquet hall B</td>
</tr>
<tr>
<td>Banquet hall C</td>
</tr>
</tbody>
</table>

In the morning, Banquet halls A, B, and C are individually used.

• Memory 2 (2-divided room setting pattern for each divided room A, and B + C)

<table>
<thead>
<tr>
<th>Change Safe group setting: Group (a)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banquet hall A</td>
</tr>
<tr>
<td>Banquet halls B + C</td>
</tr>
</tbody>
</table>

Afternoon, Banquet hall A remains in use, while Banquet halls B and C are not individually used, being combined into 1 room for which the D-2012C dedicated to Banquet hall B is used.

[Settings and usage]

• Assign input and output channels, and signal routing to the Change Safe group (a).
• Memory 1 has the setting pattern to be used for each of Banquet halls A, B, and C. No Change Safe group is set.
• Memory 2 has the setting pattern to be used for an independent Banquet hall A and a combined B & C hall separately. The Change Safe group is set to the group (a).
• When Memory 1 is switched to Memory 2, the parameters for Fader and Matrix Point belonging to the Change Safe group (a) are maintained owing to the Change Safe group function.
• If the microphone and speaker channels in Banquet hall C are set to Fader Layer 2 of the D-2012C dedicated to Banquet hall B, this allows the same D-2012C to operate for the combined B & C hall.
• In this example above, if 2 divided rooms are supposed to be fixed for use, recalling the preset Memory 2 needs the channel and routing for Banquet hall A to have been recalled first. In this case, Memory 2 cannot be used, and other preset memory assigned to no Change Safe group is required. For example, prepare and use Memory 3 having a 2-divided room setting pattern which is created for the system of Banquet hall A and a combined B & C hall with the Change Safe group set to "None."
14. SPECIFICATIONS

14.1. Software Specifications

Operating System: Windows XP Service Pack 2 or later, 32/64-bit Windows Vista, 32/64-bit Windows 7
Required Component: .NET Framework 3.5 SP1
Preset Memory: 32 memories
Bus channel: 4 – 24 buses

14.2. Setting Items, Setting Ranges, and Initial Value

14.2.1. Communication settings

<table>
<thead>
<tr>
<th>Unit</th>
<th>Initial IP address</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-2008SP</td>
<td>192.168.14.1</td>
</tr>
<tr>
<td>D-2012C</td>
<td>192.168.14.11</td>
</tr>
</tbody>
</table>

14.2.2. Signal processing box

[Input Matrix (Bus Assignment and Crosspoint Gain) Settings]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio In 1 – 34</td>
<td>Audio Bus 1 – 24: ON, OFF</td>
<td>– – –</td>
</tr>
<tr>
<td>CobraNet In 1 – 16</td>
<td>Audio Bus 1 – 24: ON, OFF</td>
<td>– – –</td>
</tr>
<tr>
<td>Gain</td>
<td>$-\infty, -69 - 0 \text{ dB}, 1 \text{ dB steps}$</td>
<td>0 dB</td>
</tr>
</tbody>
</table>

[Output Matrix (Bus Assignment and Crosspoint Gain) Settings]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Bus 1 – 24</td>
<td>Audio Out 1 – 32: ON, OFF</td>
<td>– – –</td>
</tr>
<tr>
<td></td>
<td>CobraNet Out 1 – 16: ON, OFF</td>
<td>– – –</td>
</tr>
<tr>
<td>Ext. In 1 – 4</td>
<td>Audio Out 1 – 32: ON, OFF</td>
<td>– – –</td>
</tr>
<tr>
<td></td>
<td>CobraNet Out 1 – 16: ON, OFF</td>
<td>– – –</td>
</tr>
<tr>
<td>CobraNet Bus 1 – 16</td>
<td>Audio Out 1 – 32: ON, OFF</td>
<td>– – –</td>
</tr>
<tr>
<td></td>
<td>Gain</td>
<td>$-\infty, -69 - 0 \text{ dB}, 1 \text{ dB steps}$</td>
</tr>
</tbody>
</table>

[Gain Settings]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Trim Gain</td>
<td>$-15 \text{ to } +15 \text{ dB}, 0.1 \text{ dB steps}$</td>
<td>0 dB</td>
</tr>
<tr>
<td>Input Trim Polarity</td>
<td>Normal, Inverse</td>
<td>Normal</td>
</tr>
</tbody>
</table>
### Fader Settings

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio In Fader Gain</td>
<td>$-\infty$ to $+10$ dB, 0.1 dB steps</td>
<td>$-\infty$ dB</td>
</tr>
<tr>
<td>CobraNet In Fader Gain</td>
<td>$-\infty$ to $+10$ dB, 0.1 dB steps</td>
<td>$-\infty$ dB</td>
</tr>
<tr>
<td>Audio Bus Fader Gain</td>
<td>$-\infty$ to $+10$ dB, 0.1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>Ext In. Fader Gain</td>
<td>$-\infty$ to $+10$ dB, 0.1 dB steps</td>
<td>$-\infty$ dB</td>
</tr>
<tr>
<td>CobraNet Bus Fader Gain</td>
<td>$-\infty$ to $+10$ dB, 0.1 dB steps</td>
<td>$-\infty$ dB</td>
</tr>
<tr>
<td>Audio Out Fader Gain</td>
<td>$-\infty$ to $+10$ dB, 0.1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>CobraNet Out Fader Gain</td>
<td>$-\infty$ to $+10$ dB, 0.1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>Sub In Mix Fader Gain</td>
<td>$-\infty$ to $+10$ dB, 0.1 dB steps</td>
<td>$-\infty$ dB</td>
</tr>
<tr>
<td>Fader Group Tim Gain</td>
<td>$-\infty$ to $+10$ dB, 0.1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>Channel ON/OFF</td>
<td>On, Off</td>
<td>On</td>
</tr>
<tr>
<td>Grouping number</td>
<td>Off, 1 – 255</td>
<td>Off</td>
</tr>
</tbody>
</table>

### High-Pass Filter Settings

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cutoff Frequency</td>
<td>20 Hz to 20 kHz, 1/24 octave steps</td>
<td>20 kHz</td>
</tr>
<tr>
<td>Slope</td>
<td>12 dB/oct (fixed)</td>
<td>–</td>
</tr>
<tr>
<td>Q</td>
<td>0.500 – 2.563</td>
<td>0.500</td>
</tr>
<tr>
<td>FILTER ON/OFF</td>
<td>On, Off</td>
<td>Off</td>
</tr>
</tbody>
</table>

### Low-Pass Filter Settings

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cutoff Frequency</td>
<td>20 Hz to 20 kHz, 1/24 octave steps</td>
<td>20 kHz</td>
</tr>
<tr>
<td>Slope</td>
<td>12 dB/oct (fixed)</td>
<td>–</td>
</tr>
<tr>
<td>Q</td>
<td>0.500 – 2.563</td>
<td>0.500</td>
</tr>
<tr>
<td>FILTER ON/OFF</td>
<td>On, Off</td>
<td>Off</td>
</tr>
</tbody>
</table>

### Equalizer Settings

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cutoff Frequency</td>
<td>20 Hz to 20 kHz, 1/24 octave steps</td>
<td>80, 500, 2.5 k, 12.5 kHz</td>
</tr>
<tr>
<td>Gain (Boost/cut)</td>
<td>– 15 to +15 dB, 0.1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>Q</td>
<td>0.267 – 69.249</td>
<td>4.318</td>
</tr>
<tr>
<td>FILTER ON/OFF</td>
<td>On, Off</td>
<td>On</td>
</tr>
</tbody>
</table>

### Compressor/Auto-Leveler Mode Settings

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compressor/Auto-Leveler Mode</td>
<td>Comp, Leveler</td>
<td>Comp</td>
</tr>
</tbody>
</table>
### [Compressor Settings]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>–20 to +20 dB, 1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>Ratio</td>
<td>1 : 1, 1.1 : 1, 1.2 : 1, 1.3 : 1, 1.5 : 1, 1.7 : 1, 2 : 1, 2.3 : 1, 2.6 : 1, 3 : 1, 4 : 1, 5 : 1, 7 : 1, 8 : 1, 10 : 1, 12 : 1, 20 : 1, ∞ : 1</td>
<td>1 : 1</td>
</tr>
<tr>
<td>Knee Type</td>
<td>Hard, Soft 1, Soft 2</td>
<td>Hard</td>
</tr>
<tr>
<td>Attack time</td>
<td>0.2, 0.5, 0.7, 1.0, 1.5, 2.0, 3.0, 5.0, 7.0, 10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 2000, 3000, 5000 ms</td>
<td>10 ms</td>
</tr>
<tr>
<td>Release time</td>
<td>10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 2000, 3000, 5000 ms</td>
<td>500 ms</td>
</tr>
<tr>
<td>Gain</td>
<td>–∞, –69 to +10 dB, 1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>ON/OFF</td>
<td>ON, OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>

### [Auto-Leveler Settings]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Level</td>
<td>–20 to +10 dB, 1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>Max Gain</td>
<td>0 to +20 dB, 1 dB steps</td>
<td>6 dB</td>
</tr>
<tr>
<td>Attack time</td>
<td>10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 1200, 1500, 2000, 2500, 3000, 5000, 7000, 10000 ms</td>
<td>500 ms</td>
</tr>
<tr>
<td>Release time</td>
<td>100, 200, 500, 700, 1000, 1200, 1500, 2000, 2500, 3000, 5000, 7000, 10000 ms</td>
<td>1000 ms</td>
</tr>
<tr>
<td>ON/OFF</td>
<td>ON, OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>

### [Auto-Mixing Group Settings]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-Mixing Group</td>
<td>GROUP A, GROUP B, GROUP C, GROUP D</td>
<td>GROUP A</td>
</tr>
</tbody>
</table>

### [Gate Settings]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>–50 to +20 dB, 1 dB steps</td>
<td>–40 dB</td>
</tr>
<tr>
<td>Hysteresis</td>
<td>0 to +10 dB, 1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>Depth</td>
<td>–∞, –69 to 0 dB, 1 dB steps</td>
<td>–20 dB</td>
</tr>
<tr>
<td>Hold time</td>
<td>10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 2000, 3000, 5000, 10000 ms</td>
<td>10 ms</td>
</tr>
<tr>
<td>Attack time</td>
<td>10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 2000, 3000, 5000, 10000 ms</td>
<td>10 ms</td>
</tr>
<tr>
<td>Release time</td>
<td>10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 2000, 3000, 5000, 10000 ms</td>
<td>10 ms</td>
</tr>
<tr>
<td>ON/OFF</td>
<td>ON, OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>
### [Setting Item Setting Range Initial Value]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center Frequency</td>
<td>20 Hz to 20 kHz, 1/24 octave steps</td>
<td>1000 Hz</td>
</tr>
<tr>
<td>Gain (Boost/cut)</td>
<td>-15 to +15 dB, 0.1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>Q</td>
<td>0.267 to 69.249</td>
<td>4.318</td>
</tr>
<tr>
<td>FILTER ON/OFF</td>
<td>ON, OFF</td>
<td>ON</td>
</tr>
</tbody>
</table>

### [Setting Item Setting Range Initial Value]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Mode (Dynamic Mode ON/OFF)</td>
<td>ON, OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>Auto : Dynamic (Number of the filters used in each mode)</td>
<td>0 : 12, 1 : 11, 2 : 10, 3 : 9, 4 : 8, 5 : 7, 6 : 6, 7 : 5, 8 : 4, 9 : 3</td>
<td>7 : 5</td>
</tr>
</tbody>
</table>

### [Setting Item Setting Range Initial Value]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay</td>
<td>Output delay: 0 – 1360 ms, 0.021 ms steps</td>
<td>0 ms</td>
</tr>
<tr>
<td>ON/OFF</td>
<td>ON, OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>

### [Setting Item Setting Range Initial Value]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attenuation Gain</td>
<td>0 – 20 ((10 \log_{10} \text{NOM} - 20 \log_{10} \text{NOM}))</td>
<td>10 (10 \log_{10} \text{NOM})</td>
</tr>
<tr>
<td>Dynamic Mode</td>
<td>ON, OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>

### Note

- Automatically set by the D-2008SP Digital Mixing Processor Unit's software.
### Crossover Settings

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cutoff Frequency</td>
<td>20 Hz to 20 kHz, 1/24 octave steps</td>
<td>-- -- --</td>
</tr>
<tr>
<td>Slope</td>
<td>Through, 6 dB/oct, 12 dB/octBS, 12 dB/octBW, 12 dB/octLR, 18 dB/octBS, 18 dB/octBW, 24 dB/octBS, 24 dB/octBW, 24 dB/octLR</td>
<td>12 dB/octVQ, 18 dB/octVQ, 24 dB/octVQ, -- -- --</td>
</tr>
<tr>
<td>Q</td>
<td>-- -- --</td>
<td>0.500 – 2.563</td>
</tr>
<tr>
<td>Q2</td>
<td>-- -- --</td>
<td>0.500 – 2.563</td>
</tr>
<tr>
<td>Gain</td>
<td>– 15 to +15 dB, 0.1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>Polarity</td>
<td>NORMAL, INVERSE</td>
<td>NORMAL</td>
</tr>
</tbody>
</table>

**Note:** The initial value of the cut-off frequency differs depending on the crossover combination settings.

### Combination

<table>
<thead>
<tr>
<th>Combination</th>
<th>Ch.N</th>
<th>Cut-off Frequency Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td></td>
<td>HPF: 20 Hz, LPF: 125 Hz</td>
</tr>
<tr>
<td>2way</td>
<td>Ch.N</td>
<td>HPF: 20 Hz, LPF: 2.9 kHz</td>
</tr>
<tr>
<td></td>
<td>Ch.N+1</td>
<td>HPF: 20 Hz, LPF: 2.9 kHz</td>
</tr>
<tr>
<td>3way</td>
<td>Ch.N</td>
<td>HPF: 20 Hz, LPF: 500 Hz</td>
</tr>
<tr>
<td></td>
<td>Ch.N+1</td>
<td>HPF: 20 Hz, LPF: 2.9 kHz</td>
</tr>
<tr>
<td></td>
<td>Ch.N+2</td>
<td>HPF: 20 Hz, LPF: 2.9 kHz</td>
</tr>
<tr>
<td>4way</td>
<td>Ch.N</td>
<td>HPF: 20 Hz, LPF: 125 Hz</td>
</tr>
<tr>
<td></td>
<td>Ch.N+1</td>
<td>HPF: 20 Hz, LPF: 1.25 kHz</td>
</tr>
<tr>
<td></td>
<td>Ch.N+2</td>
<td>HPF: 1.25 kHz, LPF: 8 kHz</td>
</tr>
<tr>
<td></td>
<td>Ch.N+3</td>
<td>HPF: 8 kHz, LPF: 20 kHz</td>
</tr>
</tbody>
</table>
### Filter Settings

<table>
<thead>
<tr>
<th>Filter Type</th>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parametric Equalizer (PEQ)</td>
<td>Center frequency</td>
<td>20 Hz to 20 kHz, 1/24 octave steps</td>
<td>1000 Hz</td>
</tr>
<tr>
<td></td>
<td>Gain (Boost/cut)</td>
<td>–15 to +15 dB, 0.1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td></td>
<td>Q</td>
<td>0.267 –– 69.249</td>
<td>4.318</td>
</tr>
<tr>
<td>High-pass Filter (HPF)</td>
<td>Cutoff frequency</td>
<td>20 Hz to 20 kHz, 1/24 octave steps</td>
<td>100 Hz</td>
</tr>
<tr>
<td></td>
<td>Slope</td>
<td>6 dB/oct, 12 dB/oct</td>
<td>– – –</td>
</tr>
<tr>
<td></td>
<td>Q</td>
<td>– – –</td>
<td>0.500 – 2.563</td>
</tr>
<tr>
<td>Low-pass Filter (LPF)</td>
<td>Cutoff frequency</td>
<td>20 Hz to 20 kHz, 1/24 octave steps</td>
<td>10 kHz</td>
</tr>
<tr>
<td></td>
<td>Slope</td>
<td>6 dB/oct, 12 dB/oct</td>
<td>– – –</td>
</tr>
<tr>
<td></td>
<td>Q</td>
<td>– – –</td>
<td>0.500 – 2.563</td>
</tr>
<tr>
<td>High Shelving Filter</td>
<td>Rolloff frequency</td>
<td>6 kHz to 20 kHz, 1/24 octave steps</td>
<td>6 kHz</td>
</tr>
<tr>
<td></td>
<td>Gain (Boost/cut)</td>
<td>–15 to +15 dB, 0.1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>Low Shelving Filter</td>
<td>Rolloff frequency</td>
<td>20 Hz to 500 Hz, 1/24 octave steps</td>
<td>500 Hz</td>
</tr>
<tr>
<td></td>
<td>Gain (Boost/cut)</td>
<td>–15 to +15 dB, 0.1 dB steps</td>
<td>0 dB</td>
</tr>
<tr>
<td>All Pass Filter</td>
<td>Phase reversal frequency</td>
<td>20 Hz to 20 kHz, 1/24 octave steps</td>
<td>1 kHz</td>
</tr>
<tr>
<td></td>
<td>Q</td>
<td>0.267 – 69.249</td>
<td>0.267</td>
</tr>
<tr>
<td>Notch Filter</td>
<td>Center frequency</td>
<td>20 Hz to 20 kHz, 1/24 octave steps</td>
<td>1 kHz</td>
</tr>
<tr>
<td></td>
<td>Q</td>
<td>8.651 – 69.249</td>
<td>8.651</td>
</tr>
<tr>
<td>Horn Equalizer (Horn EQ)</td>
<td>Gain</td>
<td>0 to +18 dB, 0.5 dB steps</td>
<td>0 dB</td>
</tr>
</tbody>
</table>

### 14.2.3. Settings when the CobraNet module is used

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bundle</td>
<td>0 – 65279</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Multicast bundle: 1 – 255</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unicast bundle: 256 – 65279</td>
<td></td>
</tr>
<tr>
<td>Latency and Bit Length</td>
<td>5.33 ms (20 bits), 2.67 ms (20 bits, 24 bits), 1.33 ms (20 bits, 24 bits)</td>
<td>5.33 ms (20 bits)</td>
</tr>
<tr>
<td>Conductor Priority</td>
<td>0 – 128</td>
<td>32</td>
</tr>
</tbody>
</table>

**Note**
The D-2000 Setting Software version 3.0.0 or earlier allowed the parameters to be set to 0 – 255. Though using Parameters over 128 set by this software version permits the unit to operate, it is recommended to use Parameters 128 or less.
14.2.4. Settings when the external control port is used

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial port</td>
<td>115200, 38400, 19200, 9600</td>
<td>9600</td>
</tr>
<tr>
<td>TCP/IP port</td>
<td>3000 – 49151</td>
<td>3000</td>
</tr>
<tr>
<td>Fine Gain Command</td>
<td>No Use, Use</td>
<td>No Use</td>
</tr>
</tbody>
</table>

14.2.5. Settings when the D-921E or D-921F is used

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phantom Power</td>
<td>ON, OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>PAD (Input Sensitivity)</td>
<td>–50, –36, –10, +4 dB</td>
<td>+4 dB</td>
</tr>
</tbody>
</table>

14.2.6. Settings when the D-2000AD1 is used

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phantom Power</td>
<td>ON, OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>PAD (Input Sensitivity)</td>
<td>–50, –36, –10, +4 dB</td>
<td>+4 dB</td>
</tr>
</tbody>
</table>

14.2.7. Settings when the D-937SP is used

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Selection</td>
<td>1, 2, 3, 4</td>
<td>1</td>
</tr>
</tbody>
</table>

14.2.8. Settings when the D-936R is used

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Input Mode</td>
<td>MIX ALL, SELECT</td>
<td>MIX ALL</td>
</tr>
<tr>
<td>Input Selection</td>
<td>1, 2, 3, 4</td>
<td>all On (1 – 4)</td>
</tr>
</tbody>
</table>

14.2.9. Settings when the D-981, D-983, or D-984VC is used

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Input</td>
<td>Memory, Volume Up/Down, Channel On/Off, Line Input, LED Control, None</td>
<td>1 – 8: Memory</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9 – 24: None</td>
</tr>
<tr>
<td>Contact Output</td>
<td>Memory, Normally Break, Normally Make, Channel On/Off, Through Out, Line Input, LED Control, None</td>
<td>1 – 8: Memory</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9 – 24: Normally Break</td>
</tr>
<tr>
<td>VCA (Only when D-984VC is used)</td>
<td>None, Audio In, CobraNet In, Audio Bus, Ext. In, CobraNet Bus, Audio Out, CobraNet Out</td>
<td>None</td>
</tr>
</tbody>
</table>
### 14.2.10. Settings when the D-2012C is used

#### [Fader layer settings]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recalling Fader Layer</td>
<td>Layer 1 – 4</td>
<td>Layer 1</td>
</tr>
<tr>
<td>Fader Layer Recalled When Power is Turned On</td>
<td>Last Layer, Layer 1 – 4</td>
<td>Last Layer</td>
</tr>
</tbody>
</table>

#### [Console setting view (Function key, motorized fader, and rotary encoder settings)]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function key</td>
<td>None, Memory, Memory Store, Line Input, LED Control, Fader Layer, Console Switch (Contact Output), Key Lock, Monitor Clear</td>
<td>Memory 1 – 6, Memory Store, Key Lock</td>
</tr>
<tr>
<td>Motorized Fader</td>
<td>None, Audio In, CobraNet In, Audio Bus, Ext. In, CobraNet Bus, Audio Out, CobraNet Out</td>
<td>– – –</td>
</tr>
<tr>
<td>Rotary Encoder</td>
<td>None, Audio In, CobraNet In, Audio Bus, Ext. In, CobraNet Bus, Audio Out, CobraNet Out</td>
<td>– – –</td>
</tr>
</tbody>
</table>

#### [Console SEL/MONI link settings]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SEL/MONI Link</td>
<td>Enabled, Disabled</td>
<td>Disabled</td>
</tr>
<tr>
<td>Console ID to link (ID 1 – ID 4)</td>
<td>Enabled, Disabled</td>
<td>Disabled</td>
</tr>
</tbody>
</table>

### 14.2.11. Security settings

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable User Level</td>
<td>Enabled, Disabled</td>
<td>Disabled</td>
</tr>
<tr>
<td>Create and Delete Unit, Change Unit</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
</tr>
<tr>
<td>Unit Naming, Memory Setting</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
</tr>
<tr>
<td>Store to Memories</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
</tr>
<tr>
<td>Change Safe Setting</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
</tr>
</tbody>
</table>

### 14.2.12. Change Safe setting

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable the &quot;Change Safe&quot; function</td>
<td>Enabled, Disabled</td>
<td>Disabled</td>
</tr>
<tr>
<td>Channel Setting</td>
<td>None, a, b, c, d</td>
<td>None</td>
</tr>
<tr>
<td>Memory Setting</td>
<td>a, b, c, d (permits multiple selection)</td>
<td>No selection</td>
</tr>
</tbody>
</table>
### 14.2.13. Preset Memory settings

#### Memory settings

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crossfade Time</td>
<td>0 – 10 s, 0.5 s steps</td>
<td>0 s</td>
</tr>
<tr>
<td>Change Fader Layer (ID 1 – ID 4)</td>
<td>None, 1 – 4</td>
<td>None</td>
</tr>
</tbody>
</table>

#### Initial preset memory settings

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preset Memory Recalled When Power is Turned On</td>
<td>Last Memory, Memory 1 – 32</td>
<td>Last Memory</td>
</tr>
</tbody>
</table>